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Taking a Microsoft Office  
Specialist Exam

Desktop computing proficiency is increasingly important in today’s business world. As 
a result, when screening, hiring, and training employees, employers can feel reassured 
by relying on the objectivity and consistency of technology certification to ensure the 
competence of their workforce. As an employee or job seeker, you can use technology 
certification to prove that you already have the skills you need to succeed, saving current 
and future employers the trouble and expense of training you.

Microsoft Office Specialist Certification
Microsoft Office Specialist certification for Microsoft Office 2010 is designed to assist 
employees in validating their skills with programs in the Office 2010 software suite. 
The following certification paths are available:

● A Microsoft Office Specialist (MOS) is an individual who has demonstrated proficiency 
by passing a certification exam in one or more of the Office 2010 programs, including 
Microsoft Word, Excel, PowerPoint, Outlook, and Access, or in Microsoft SharePoint.

● A Microsoft Office Specialist Expert (MOS Expert) is an individual who has taken his 
or her knowledge of Office 2010 to the next level and has demonstrated by passing  
a certification exam that he or she has mastered the more advanced features of 
Word 2010 or Excel 2010.

Selecting a Certification Path
When deciding which certifications you would like to pursue, you should assess the 
following:

● The program and program version(s) with which you are familiar
● The length of time you have used the program and how frequently you use it
● Whether you have had formal or informal training in the use of that program
● Whether you use most or all of the available program features
● Whether you are considered a go-to resource by business associates, friends, and 

family members who have difficulty with the program
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Candidates for MOS-level certification are expected to successfully complete a wide range 
of standard business tasks, such as formatting a document or worksheet and its content; 
creating and formatting visual content; or working with SharePoint lists, libraries, Web Parts, 
and dashboards. Successful candidates generally have six or more months of experience 
with the specific Office program, including either formal, instructor-led training or self-study 
using MOS-approved books, guides, or interactive computer-based materials.

Candidates for MOS Expert-level certification are expected to successfully complete more 
complex tasks that involve using the advanced functionality of the program. Successful 
candidates generally have at least six months, and may have several years, of experience 
with the programs, including formal, instructor-led training or self-study using MOS-
approved materials.

Test-Taking Tips
Every MOS certification exam is developed from a set of exam skill standards (referred to 
as the objective domain) that are derived from studies of how the Office 2010 programs 
or SharePoint are used in the workplace. Because these skill standards dictate the scope of 
each exam, they provide critical information about how to prepare for certification. This 
book follows the structure of the published exam objectives; see “Using This Book to 
Study for a Certification Exam” at the beginning of this book for more information.

The MOS certification exams for the Office 2010 programs and SharePoint are performance 
based and require you to complete business-related tasks in the program for which you 
are seeking certification. You might be told to adjust program settings or be presented 
with a file and told to do something specific with it. Your score on the exam reflects how 
well you perform the requested tasks within the allotted time.

Here is some helpful information about taking the exam:

● Keep track of the time. You have 50 minutes to complete the exam. Your exam time 
does not officially begin until after you finish reading the instructions provided at the 
beginning of the exam. During the exam, the amount of time remaining is shown at 
the bottom of the exam interface. You can’t pause the exam after you start it.

● Pace yourself. At the beginning of the exam, you will be told how many questions 
are included in the exam. Some questions will require that you complete more than 
one task. During the exam, the number of completed and remaining questions is 
shown at the bottom of the exam interface.
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● Read the exam instructions carefully before beginning. Follow all the instructions 
provided in each question completely and accurately.

● Enter requested information as it appears in the instructions, but without duplicating 
the formatting unless you are specifically instructed to do so. For example, the text 
and values you are asked to enter might appear in the instructions in bold and under-
lined text, but you should enter the information without applying these formats.

● Close all dialog boxes before proceeding to the next exam question unless you are 
specifically instructed not to do so.

● Don’t close task panes before proceeding to the next exam question unless you are 
specifically instructed to do so.

● If you are asked to print a document, worksheet, chart, report, or slide, perform the 
task, but be aware that nothing will actually be printed.

● Don’t worry about extra keystrokes or mouse clicks. Your work is scored based on its 
result, not on the method you use to achieve that result (unless a specific method is 
indicated in the instructions).

● If a computer problem occurs during the exam (for example, if the exam does not 
respond or the mouse no longer functions) or if a power outage occurs, contact a 
testing center administrator immediately. The administrator will restart the com-
puter and return the exam to the point where the interruption occurred, with your 
score intact.

Strategy This book includes special tips for effectively studying for the Microsoft Office 
Specialist exams in Strategy paragraphs such as this one .

Certification Benefits
At the conclusion of the exam, you will receive a score report, indicating whether you 
passed the exam. You can print with the assistance of the testing center administrator. If 
your score meets or exceeds the passing standard (the minimum required score), you will 
be contacted by email by the Microsoft Certification Program team. The email message 
you receive will include your Microsoft Certification ID and links to online resources, 
including the Microsoft Certified Professional site. On this site, you can download or 
order a printed certificate, create a virtual business card, order an ID card, view and 
share your certification transcript, access the Logo Builder, and access other useful and 
interesting resources, including special offers from Microsoft and affiliated companies.
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Using the Logo Builder, you can create a personalized certification logo that includes 
the MOS logo and the specific programs in which you have achieved certification. If 
you achieve MOS certification in multiple programs, you can include up to six of them 
in one logo.

 

You can include your personalized logo on business cards and other personal promotional 
materials. This logo attests to the fact that you are proficient in the applications or cross-
application skills necessary to achieve the certification.

For More Information
To learn more about the Microsoft Office Specialist exams and related courseware, visit:

www.microsoft.com/learning/en/us/certification/mos.aspx
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Using This Book to Study  
for a Certification Exam

The Microsoft Office Specialist (MOS) exams for individual Microsoft Office 2010 programs 
are practical rather than theoretical. You must demonstrate that you can complete certain 
tasks rather than simply answering questions about program features. The successful 
MOS certification candidate will have at least six months of experience using all aspects 
of the application on a regular basis; for example, using Microsoft Outlook at work to 
send messages, track contact information, schedule appointments and meetings, track 
and assign tasks, and take notes.

This book has been designed to guide you in studying the types of tasks you are likely 
to be required to demonstrate in the MOS exams for Microsoft Word 2010, Excel 2010, 
PowerPoint 2010, and Outlook 2010.

Each part of the book covers one exam. The coverage for each exam is divided into chapters 
representing broad skill sets, and each chapter is divided into sections addressing groups 
of related skills. Each section includes review information, generic procedures, and practice 
tasks you can complete on your own while studying. When necessary, we provide prac-
tice files you can use to work through the practice tasks. You can practice the procedures 
in this book by using the practice files supplied or by using your own files. (If you use 
your own files, keep in mind that functionality in some Office 2010 programs is limited  
in files created in or saved for earlier versions of the program. When working in such a 
file, Compatibility Mode appears in the program window title bar.)

As a certification candidate, you probably have a lot of experience with the program 
you want to become certified in. Many of the procedures we discuss in this book will be 
familiar to you; others might not be. Read through each study section and ensure that 
you are familiar with not only the procedures included in the section, but also the con-
cepts and tools discussed in the review information. In some cases, graphics depict the 
tools you will use to perform procedures related to the skill set. Study the graphics and 
ensure that you are familiar with all the options available for each tool.

Throughout this book, you will find Strategy tips presenting additional methods of study 
you can pursue on your own to ensure that you achieve mastery of a skill set and are 
successful in your certification effort.



xxiv  Using This Book to Study for a Certification Exam

Features and Conventions of This Book
If you have worked with previous versions of Word, Excel, PowerPoint, or Outlook, or if 
you need help remembering how to perform a particular task, the following features of 
this book will help you locate specific information:

● Detailed table of contents Scan a listing of the topics covered in each chapter 
and locate specific topics.

● Chapter thumb tabs Easily locate the beginning of the chapter you want.

● Detailed index Look up specific tasks and general concepts in the index, which 
has been carefully crafted with the reader in mind.

You can save time when you use this book by understanding how special instructions, 
keys to press, buttons to click, and other conventions are indicated in this book.

Convention Meaning

1
2

Numbered steps guide you through step-by-step procedures.

➜ An arrow indicates a procedure that has only one step.
Practice Files This paragraph at the end of a chapter introduction provides information 

about the practice files provided as part of the companion media for use 
in the chapter.

See Also These paragraphs direct you to more information about a given topic in 
this book or elsewhere.

Tip These paragraphs provide a helpful hint or shortcut that makes working 
through a task easier, or information about other available options.

Strategy These paragraphs provide additional exam study tips.
Interface  
elements

In procedures, the names of program elements (such as buttons and 
commands) are shown in bold characters.

Key  
combinations

A plus sign (+) between two key names means that you must hold 
down the first key while you press the second key. For example, “press 
Ctrl+Home” means “hold down the Ctrl key and press the Home key.”

User input In procedures, anything you should enter appears in bold italic characters.
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Using the Book’s Companion Content
Before you can complete the exercises in this book, you need to copy the book’s practice 
files to your computer. These practice files, and other information, can be downloaded 
from here:

http://www.microsoftpressstore.com/title/9780735648753

Go to the detail page in your web browser and follow the instructions for downloading 
the files.

Important The Microsoft Word 2010, Excel 2010, PowerPoint 2010, and Outlook 2010 
programs are not available from this website . You should purchase and install those pro-
grams before using this book .

The following tables list the practice files for this book.

Exam 77-881: Microsoft Word 2010

Folder/Objective File
Word\Objective1 
1 Sharing and Maintaining Documents

ExecutiveResume.dotx
Finalizing.docx
Orchestra.docx
Password.docx
Saving1.docx
Saving2.docx
Saving3.docx
UrbanResume.dotx
Versions.docx
Viewing1.docx
Viewing2.docx

(continued)
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Folder/Objective File
Word\Objective2 
2 Formatting Content

Characters.docx
Finding.docx
Lists.docx
ModifyTable.docx
Paragraphs.docx
RoomPlanner.docx
SortTable.docx
Styles.docx
Table.docx
Tabs.docx
TabularList.docx

Word\Objective3 
3 Applying Page Layout and Reusable Content

Background.docx
Columns.docx
CustomTheme.docx
Header.docx
Numbers.docx
Pages.docx
Parts.docx
SavedText.docx
Theme.docx

Word\Objective4 
4 Including Illustrations and Graphics in a 
Document

ClipArt.docx
Logo.png
Picture.docx
Shapes.docx
SmartArt.docx
TextBoxes.docx
WordArt.docx

Word\Objective5 
5 Proofreading Documents

Comments.docx
Letter.docx

Word\Objective6 
6 Applying References and Hyperlinks

Contents.docx
Footnotes.docx
Hyperlinks.docx
OtherLogos.docx

Word\Objective7 
7 Performing Mail Merge Operations

AnniversaryLetter.docx
CustomerList.xlsx
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Exam 77-882: Microsoft Excel 2010

Folder/Objective File
Excel\Objective1 
1 Managing the Worksheet Environment

HeaderFooter.xlsx
PageBreaks.xlsx
PopulationData.xlsx
PrintArea.xlsx
Properties.xlsx

Excel\Objective2 
2 Creating Cell Data

FillCopies.xlsx
FillCustom.xlsx
FillSeries.xlsx
Hyperlink.xlsx
InsertingDeleting.xlsx

Excel\Objective3 
3 Formatting Cells and Worksheets

FormatCells.xlsx
HeightWidth.xlsx
Hiding.xlsx
Hyperlink.xlsx
Layout.xlsx
RowColumnFormatting.xlsx

Excel\Objective4 
4 Managing Worksheets and Workbooks

AirQualityData.xlsx
PersonalMonthlyBudget.xlsx
PopulationData.xlsx
SalesReport.xlsx

Excel\Objective5 
5 Applying Formulas and Functions

CellRange.xlsx
ConditionalFormula.xlsx
MultiplicationTable.xlsx
Sales.xlsx
SalesBySeason.xlsx
SummaryFormula.xlsx

(continued)
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Folder/Objective File
Excel\Objective6 
6 Presenting Data Visually

ChartElements.xlsx
ClipArt.xlsx
DataSource.xlsx
Editing.xlsx
Logo2.jpg
PersonalMonthlyBudget.xlsx
Picture.xlsx
Plotting.xlsx
Pollution.pptx
Shapes.xlsx
SizingMoving.xlsx
SmartArt.xlsx
Sparklines.xlsx
VariegatedGrass.jpg

Excel\Objective7 
7 Sharing Worksheet Data with Other Users

Comments.xlsx
Saving.xlsx

Excel\Objective8 
8 Analyzing and Organizing Data

ConditionalFormatting.xlsx
Filtering.xlsx
Sorting.xlsm

Exam 77-883: Microsoft PowerPoint 2010

Folder/Objective File
PowerPoint\Objective1 
1 Managing the PowerPoint Environment

BuyingTripsA.pptx
BuyingTripsB.pptx
WaterSaving.pptx
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Folder/Objective File
PowerPoint\Objective2 
2 Creating a Slide Presentation

AnnualGeneralMeeting.pptx
BuyingTrips.pptx
Chrysanthemum.jpg
CommunityService.pptx
Daisies.jpg
Frangipani.jpg
Harmony.pptx
Hydrangeas.jpg
Orientation.docx
Projects.pptx
Service.pptx
Tulips.jpg
WaterLilies.jpg
WaterSaving.pptx

PowerPoint\Objective3 
3 Working with Graphical and Multimedia 
Elements

Bear.wmv
Bravo.jpg
InMyBackyard.pptx
ManagingYourTime.pptx
PhotoAlbum.pptx
Pollution.pptx
ShareholdersMeeting.pptx
StatusMeeting.pptx

PowerPoint\Objective4 
4 Creating Charts and Tables

AirQuality.pptx
Costs.xlsx
Temperature.pptx
TimeManagement.pptx
WaterConsumption.xlsx
WaterSaving.pptx
WaterStrategies.pptx

(continued)
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Folder/Objective File
PowerPoint\Objective5 
5 Applying Transitions and Animations

AnnualMeeting.pptx
BackyardEcology.pptx
NaturalBackyard.pptx
NaturalGardening.pptx
PersonalJournal.pptx

PowerPoint\Objective6 
6 Collaborating on Presentations

AnnualMeetingA.pptx
AnnualMeetingB.pptx
CommunityService.pptx
CompanyMeeting.pptx
WaterUse.pptx

PowerPoint\Objective7 
7 Preparing Presentations for Delivery

Color.pptx
Harmony.pptx
HealthyEcosystems.pptx
Meeting.pptx
YinYang.png

PowerPoint\Objective8 
8 Delivering Presentations

BackyardEcosystems.pptx
DirectorsMeeting.pptx
Landscaping.pptx
Meeting.pptx

Exam 77-884: Microsoft Outlook 2010

Folder/Objective File
none 
1 Managing the Outlook Environment

none

Outlook\Objective2 
2 Creating and Formatting Item Content

Brochure.docx
KauaiLighthouse.jpg
Regulations.docx
Strategy.pptx

none 
3 Managing Email Messages

none

Outlook\Objective4 
4 Managing Contacts

OTSI-Logo.png

Outlook\Objective5 
5 Managing Calendar Objects

Agenda.docx

Outlook\Objective6 
6 Working with Tasks, Notes, and Journal Entries

ServiceProject.docx
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Modifying the Display of the Ribbon
The goal of the Microsoft Office working environment is to make working with Office 
documents, including Microsoft Word documents, Excel workbooks, PowerPoint presenta-
tions, Outlook email messages, and Access database tables, as intuitive as possible. You 
work with an Office file and its contents by giving commands to the program in which 
the document is open. All Office 2010 programs organize commands on a horizontal 
bar called the ribbon, which appears across the top of each program window whether 
or not there is an active document.

 

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some  
appear in galleries. Some groups have related dialog boxes or task panes that contain 
additional commands. 

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this topic, we discuss the general appearance 
of the ribbon, things that affect its appearance, and ways of locating commands that 
aren’t visible on compact views of the ribbon.

Tip Some older commands no longer appear on the ribbon but are still available in 
the program . You can make these commands available by adding them to the Quick 
Access Toolbar .

Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon changes 
as the width of the ribbon changes. A command might be displayed on the ribbon in the 
form of a large button, a small button, a small labeled button, or a list entry. As the width 
of the ribbon decreases, the size, shape, and presence of buttons on the ribbon adapt to 
the available space.
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For example, when sufficient horizontal space is available, the buttons on the Review 
tab of the Outlook program window are spread out and you’re able to see more of the 
commands available in each group.

 

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons are hidden under one button that represents the group. Click the group button 
to display a list of the commands available in that group.

 

When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.

 

Changing the Width of the Ribbon
The width of the ribbon is dependent on the horizontal space available to it, which depends 
on these three factors:

● The width of the program window Maximizing the program window provides the 
most space for ribbon elements. You can resize the program window by clicking 
the button in its upper-right corner or by dragging the border of a nonmaximized 
window.
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Tip On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen .

● Your screen resolution Screen resolution is the size of your screen display expressed 
as pixels wide × pixels high. The greater the screen resolution, the greater the amount 
of information that will fit on one screen. Your screen resolution options are depend-
ent on your monitor. At the time of writing, possible screen resolutions range from 
800 × 600 to 2048 × 1152. In the case of the ribbon, the greater the number of pixels 
wide (the first number), the greater the number of buttons that can be shown on the 
ribbon, and the larger those buttons can be.

On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution window of Control Panel. 

 

● The density of your screen display You might not be aware that you can change the 
magnification of everything that appears on your screen by changing the screen mag-
nification setting in Windows. Setting your screen magnification to 125 percent makes 
text and user interface elements larger on screen. This increases the legibility of infor-
mation, but means that less information fits onto each screen.
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On a computer running Windows 7, you can change the screen magnification from 
the Display window of Control Panel. You can choose one of the standard display 
magnification options, or create another by setting a custom text size.

 

See Also For more information about display settings, refer to Windows 7 Step by 
Step (Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or 
Windows XP Step by Step (Microsoft Press, 2002) by Joan Lambert and Joyce Cox .

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text and 
screen elements to 120 dpi. You can choose a custom setting of up to 500 percent 
magnification, or 480 dpi, in the Custom DPI Setting dialog box.
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Tip You can choose a magnification of up to 200 percent from the lists or choose a 
greater magnification by dragging across the ruler from left to right .

Adapting Procedure Steps
The screen images shown in the procedures in this book were captured at a screen reso-
lution of 1024 × 768, at 100 percent magnification, and with the default text size (96 
dpi). If any of your settings are different, the ribbon on your screen might not look the 
same as the one shown in the book. For example, you might see more or fewer buttons in 
each of the groups, the buttons you see might be represented by larger or smaller icons 
than those shown, or the group might be represented by a button that you click to display 
the group’s commands.

When we instruct you to give a command from the ribbon in a procedure, we do it in 
this format:

● On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

● On the Page Layout tab, in the Page Setup group, display the Breaks list, and then 
click Page.
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If differences between your display settings and ours cause a button on your screen to 
look different from the one mentioned in this Study Guide, you can easily adapt the 
steps to locate the command. First, click the specified tab. Then locate the specified 
group. If a group has been collapsed into a group list or group button, click the list or 
button to display the group’s commands. Finally, look for a button that features the 
same icon in a larger or smaller size than that shown in the book. If necessary, point to 
buttons in the group to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the procedures in the book.
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Your Companion eBook
The eBook edition of this book allows you to:

● Search the full text

● Print

● Copy and paste

To download your eBook, please see the instruction page at the back of this book.
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Getting Support and Giving Feedback

Errata
We’ve made every effort to ensure the accuracy of this book and its companion content. 

 
 2. In the Search box, enter the book’s ISBN or title.

 
 

You’ll find additional information and services for your book on its catalog page. If you 

at mspinput@microsoft.com.

Getting Help with Microsoft Office 2010
If your question is about Microsoft Word 2010, Excel 2010, PowerPoint 2010, or Outlook 
2010, and not about the content of this Microsoft Press book, your first recourse is the 
Microsoft Office Help system. You can find general or specific Help information in a 
couple of ways:

● In the program window, you can click the Help button (labeled with a question 
mark) located in the upper-right corner of the web browser window to display  
the program-specific Help window.

● In the left pane of the Backstage view, you can click Help to access Microsoft 
Office Help resources.

If you do find an error, please report it on our Microsoft Press site:

1. Go to microsoftpressstore.com.

3. Select your book from the search results.

find the Errata and Updates tab. 4. On your book’s catalog page,

Tip Product support for Microsoft software is not offered through the Microsoft Press 

need additional support, please send an email message to Microsoft Press Book Support  

Book Support email address .
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If your question is about Word 2010, Excel 2010, PowerPoint 2010, Outlook 2010, or 
another Microsoft software product and you cannot find the answer in the product’s 
Help system, please search the appropriate product solution center or the Microsoft 
Knowledge Base at:

support.microsoft.com/

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/

We Want to Hear from You
At Microsoft Press, your satisfaction is our top priority, and your feedback our most 
valuable asset. Please tell us what you think of this book at:

www.microsoft.com/learning/booksurvey/

The survey is short, and we read every one of your comments and ideas. Thanks in 
advance for your input!

Stay in Touch
Let’s keep the conversation going! We’re on Twitter: twitter.com/MicrosoftPress.
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 3	 Formatting	Cells	
	 	 and	Worksheets
The skills tested in this section of the Microsoft Office Specialist exam for Microsoft 
Excel 2010 relate to changing the appearance of worksheets and worksheet data. 
Specifically, the following objectives are associated with this set of skills:

3.1 Apply and Modify Cell Formats
3.2 Merge or Split Cells
3.3 Create Row and Column Titles
3.4 Hide or Unhide Rows and Columns
3.5 Manipulate Page Setup Options for Worksheets
3.6 Create and Apply Cell Styles

Worksheets can contain just a few columns and rows of data or complex calculations 
involving hundreds of cells. The goal of formatting a worksheet is to structure the 
data in such a way that no matter what size the worksheet is, key information is readily 
identifiable. With Excel, you can format the information in an ordinary worksheet on 
three levels: you can manipulate the worksheet as a whole, work with entire columns 
or rows, and change individual cells to achieve precisely the results you want. If you 
define a range of cells as a table, you have additional formatting options available.

This chapter guides you in studying ways of formatting cells and worksheets by using cell 
formats and styles; merging and splitting cells; and hiding, displaying, and printing row 
and column titles. You also study page setup options for worksheets.

Practice Files	 Before	you	can	complete	the	practice	tasks	in	this	chapter,	you	need	
to	copy	the	book’s	practice	files	to	your	computer.	The	practice	files	you’ll	use	to	complete	
the	tasks	in	this	chapter	are	in	the	Excel\Objective3	practice	file	folder.	A	complete	list	
of	practice	files	is	provided	in	“Using	the	Book’s	Companion	Content”	at	the	beginning	of	
this	book.
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3.1	 Apply	and	Modify	Cell	Formats
Formatting	Cell	Content
By default, the font used for entries in a new Excel worksheet is Calibri, but you can use 
the same techniques you would use in any Office 2010 program to change the font 
and the following font attributes:

● Size
● Style
● Color
● Underline

You can change several attributes at once in the Format Cells dialog box.

 

Tip	 By	default,	row	height	is	dynamic	and	grows	to	fit	the	size	of	the	cell	content.	If	you	
manually	change	the	height	of	a	row	and	then	change	the	font	size	of	text	in	that	row,	
you	might	have	to	adjust	the	row.	For	more	information	about	adjusting	row	height,	see	
the	“Setting	Row	Height	and	Column	Width”	topic	later	in	this	section.

Text formatting can be applied to one cell, an entire row, an entire column, or the entire 
worksheet.
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You might want to apply the following:

●	 Text	wrapping	 By default, Excel does not wrap text in a cell. Instead, it allows the 
entry to overflow into the cell to the right if that cell is empty, or hides the part 
that won’t fit if the cell to the right contains its own entry. To make the entire entry 
visible, you can allow the cell entry to wrap to multiple lines, which increases the 
height of the row.

Tip	 Increasing	the	height	of	one	cell	increases	the	height	of	the	entire	row.

●	 Alignment	 By default, text is left aligned and numbers are right aligned. You can 
specify a particular horizontal alignment, and you can specify whether multiline 
entries should start at the top of their cells and go down, be centered, or start at 
the bottom of their cells and go up.

●	 Orientation	 By default, entries are horizontal and read from left to right. You can 
rotate entries for special effect or to allow you to display more information on the 
screen or a printed page. This capability is particularly useful when you have long 
column headers above columns of short entries.

Tip	 You	can	apply	text	wrapping,	alignment,	and	orientation	formatting	to	any	cell,	
but	bear	in	mind	that	some	kinds	of	formatting	can	detract	from	the	readability	of	a	
worksheet	if	they	are	applied	haphazardly.

➤ To format all the characters in a selected cell

➜ On the Home tab, click buttons in the Font group.
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➤ To format some of the characters in a cell

 1. In the Formula	Bar or in the cell, select the text you want to format.

 2. On the Home tab, click buttons in the Font group.

Or

Click buttons on the Mini Toolbar that appears.

➤ To allow the entries in a selected column to wrap

➜ On the Home tab, in the Alignment group, click the Wrap	Text button.

Tip	 If	all	the	text	in	a	cell	is	not	visible	after	you	click	the	Wrap	Text	button,	it	might	be	
because	the	row	is	set	to	a	specific	height.

➤ To align the entries of a selected column

➜ On the Home tab, in the Alignment group, click the Align	Text	Left, Center, or 
Align	Text	Right button to specify horizontal alignment, or click the Top	Align, 
Middle	Align, or Bottom	Align button to specify vertical alignment.

➤ To change the orientation of a selected row of headers

➜ On the Home tab, in the Alignment group, click the Orientation button, and then 
click the angle you want in the list.

Tip	 You	can	change	the	text	alignment,	text	control,	text	direction,	and	text	orientation	
settings	on	the	Alignment	page	of	the	Format	Cells	dialog	box.

➤ To apply existing formatting to other cells

 1. Select the cell or cells from which you want to copy formatting.

 2. On the Home tab, in the Clipboard group, click the Format	Painter button to store 
the formatting of the selected cell for a single use.

Or

In the Clipboard group, double-click the Format	Painter button to store the 
formatting of the selected cell for multiple uses.

 3. Drag the paintbrush-shaped cursor across the cell or cells to which you want to 
apply the stored formatting.

 4. If necessary, click the Format	Painter button or press Esc to turn off the Format 
Painter tool.
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Formatting	Cell	Fills	and	Borders
You can format cells by using borders and shading to make them stand out. You can 
add predefined borders or custom borders of various styles, colors, and thicknesses to a 
single cell or to multiple cells. You can apply solid colors, gradients, and patterns to the 
background of one or more cells as creative ways of delineating structure and drawing 
attention to key information.

➤ To change the color of a selected cell

➜ On the Home tab, in the Font group, click the Fill	Color button to apply the 
active color.

➜ In the Font group, click the Fill	Color arrow, and then click a theme color or a 
standard color in the palette.

Tip	 Clicking	More	Colors	at	the	bottom	of	the	palette	opens	the	Colors	dialog	box,	
where	you	have	a	wider	range	of	choices	(more	than	16	million).

➤ To add a border to a selected cell

➜ On the Home tab, in the Font group, click the Border button to apply the most 
recent border.

➜ In the Font group, on the Border menu, click the border you want.

Or

 1. In the Font group, on the Border menu, click Draw	Border.

 2. When the cursor changes to a pencil, drag to draw border lines and boxes.

 3. Press Esc to turn off the Draw Border function.

Or

 1. In the Font group, on the Border menu, click More	Borders.

 2. On the Border page of the Format	Cells dialog box, in the Line area, click a line 
style and color.

 3. In the Border area, click in the preview pane to draw border lines. Click unwanted 
border lines to remove them.

 4. In the Format	Cells dialog box, click OK.

➤ To remove the border from a selected cell

➜ On the Home tab, in the Font group, click No	Borders in the Border list.



208  	 Exam	77-882	 Microsoft	Excel	2010

See Also	 For	information	about	conditional	formatting,	see	section	8.3,	“Apply	
Conditional	Formatting.”

Setting	Row	Height	and	Column	Width
By default, worksheet rows have a standard height of 15 points (1 point equals approxi-
mately 1/72 inch) and their height increases and decreases to accommodate the number 
of lines in their longest entry. You can manually change the height of a row, but it is 
best to leave it automatic unless you have a good reason to specify a particular height. 
For example, you might want to specify a narrow row to create a visual break between 
blocks of data. (You can restore dynamic height adjustment if you need to.)

By default, worksheet columns have a standard width of 8.43 characters. Column width 
does not always automatically adjust to fit the column contents. You are more likely to 
want to change column width than row height, usually to accommodate long cell entries. 
You can have Excel adjust a column to fit its longest entry, or you can adjust it manually. In 
conjunction with text wrapping, adjusting column widths is a key technique for making as 
much data as possible visible on the screen or page.
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See Also	 For	information	about	text	wrapping,	see	the	“Formatting	Cell	Content”	topic	
earlier	in	this	section.

To adjust rows and columns manually, you can use two methods:

● Drag the border of a row heading or column heading. As you drag, a ScreenTip 
displays the new dimension of the row or column.

● Adjust the settings in a dialog box.

 

For the purposes of height and width adjustments, selecting a single cell in a row or 
column is the same as selecting the entire row or column. You can select multiple rows 
or columns to change all their heights or widths at the same time.

➤ To change the height of a selected row

➜ Drag the bottom border of the row heading up or down.

Or

 1. On the Home tab, in the Cells group, display the Format list, and then click Row	
Height.

 2. In the Row	Height dialog box, specify the height you want, and then click OK.

➤ To change the width of a selected column

➜ Drag the right border of the column heading to the left or right.

Or

 1. On the Home tab, in the Cells group, display the Format list, and then click 
Column	Width.

 2. In the Column	Width dialog box, specify the width you want, and then click OK.
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➤ To automatically size a row to fit its contents

➜ On the Home tab, in the Cells group, display the Format list, and then click AutoFit 
Row	Height.

➤ To automatically size a column to fit its contents

➜ Double-click the right border of the column heading.

➜ On the Home tab, in the Cells group, display the Format list, and then click AutoFit 
Column	Width.

Tip	 You	can	adjust	the	width	of	all	the	columns	in	a	worksheet	at	the	same	time.	Click	
the	worksheet	selector	to	select	the	entire	worksheet,	and	then	double-click	the	border	
between	any	two	columns.	Every	column	resizes	to	fit	its	contents.	Empty	columns		
remain	unchanged.

Formatting	Numbers

Strategy	 Knowing	which	number	format	is	appropriate	for	which	type	of	data	is	important	
for	efficient	worksheet	construction.	Take	the	time	to	explore	the	formats	so	that	you	under-
stand	which	one	to	apply	when.

By default, all the cells in a new worksheet are assigned the General format. When setting 
up a worksheet, you assign to cells the format that is most appropriate for the type of infor-
mation you expect them to contain. The format determines not only how the information 
looks but also how Excel can work with it.

You can assign the format before or after you type an entry in the cell. You can also just 
start typing and have Excel intuit the format from what you type. If you choose the format 
from the list or allow Excel to assign it for you, the format is applied with its default settings. 
For number and currency formats, you can change those settings in limited ways by clicking 
buttons on the Home tab. For all formats, you can change them in more precise ways in the 
Format Cells dialog box.
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If none of the number formats is exactly what you want, you can modify an existing 
format to define your own. Your format then appears in a list of custom formats so 
that you can reuse it elsewhere in the workbook.

Tip	 A	custom	format	is	saved	in	the	workbook	in	which	it	is	created	and	is	not	available	
for	other	workbooks	unless	you	save	the	workbook	containing	the	custom	format	as	an	
Excel	template.

Strategy	 The	rules	for	constructing	custom	formats	are	complex.	For	the	exam,	you	might	
be	asked	to	modify	a	format	in	simple	ways,	so	you	should	become	familiar	with	the	char-
acters	used	in	a	format	and	how	to	represent	and	format	different	types	of	data.

A number format can include up to four sections that correspond to positive numbers, 
negative numbers, zero values, and text, separated by semicolons, such as the following:

<POSITIVE>;<NEGATIVE>;<ZERO>;<TEXT>
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You don’t have to include all the sections in the format, but you must include semi-
colons if you leave a section blank. For example, you could configure the following 
custom formatting:

[Blue]#,##0.00_);[Red](#,##0.00);0.00;”Test “@

This would result in the following display based on the value entered:

Value entered Value displayed Description

123 (<positive>) 123.00 Blue text, right aligned, moved one space left

-123 (<negative>) (123.00) Red text, right aligned

0 (<zero>) 0.00 Default font color, right aligned

One (<text>) Test One Default font color, left aligned

See Also  For a full list of characters that are valid in a custom number format, see 
“Guidelines for Including Text and Adding Spacing” in the Excel Help topic “Create  
a custom number format.”
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➤ To apply a default data format to a selected cell

➜ On the Home tab, in the Number group, display the Number	Format list, and then 
click a format.

Tip	 If	you	want	a	number	to	be	treated	as	text,	apply	the	text	format.

➤ To refine a number or currency format

➜ On the Home tab, in the Number group, click buttons to add a currency symbol, 
percent sign, or comma; or to increase or decrease the number of decimal places.

Or

 1. On the Home tab, click the Number dialog box launcher.

 2. In the Format	Cells dialog box, with the format selected in the Category list, adjust 
the settings, and then click OK.

➤ To create a custom format

 1. On the Home tab, click the Number dialog box launcher.

 2. In the Format	Cells dialog box, in the Category list, click Custom.

 3. In the Type list, select a format that is close to the one you want, and then in the 
Type box, modify the format to meet your needs.

 4. Click OK to apply the custom format to the selected cell(s).

➤ To delete a custom format

 1. On the Number page of the Format	Cells dialog box, in the Category list, click 
Custom.

 2. In the Type list, select the custom format, and click Delete. Then click OK.

Tip	 You	cannot	delete	a	built-in	format	from	the	Type	list.
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Practice	Tasks

The practice files for these tasks are located in the Excel\Objective3 practice file folder. 
If you want to save the results of the tasks, save them in the same folder with My 
appended to the file name so that you don’t overwrite the original practice file.

● On the Expense Statement worksheet of the FormatCells workbook, format 
cell K10 to display its contents in any one of the number formats (Number, 
Currency, or Accounting) with no decimal places. Then apply the same for-
matting to cells K11:K23.

● On the Expense Statement worksheet of the FormatCells workbook, apply 
custom number formatting to the TOTAL value in cell K23 that will cause it 
to be displayed in green if it is a positive number and red if it is a negative 
number. Do not add formatting for zero or text values. Verify the formatting 
by entering a value of 3,000 in cell K22.

● On the Expense Statement worksheet of the FormatCells workbook, change 
the font size of the headers in cells A9:K9. In cells A9:K9 and K10:K19, apply 
a background color that is two shades darker than the current one. Lastly, 
place a thick box border around the merged cells in row 2.

● On the Expense Statement worksheet of the RowColumnFormatting workbook, 
and set the entire worksheet so that all entries wrap in their cells. Right-align 
the entries in column A, and bottom-align the headers in row 9. Finally, turn 
off text wrapping in rows 4, 5, and 9, and turn the headers in row 9 sideways 
at a 45-degree angle.

● On the Inventory List worksheet of the HeightWidth workbook, set the height of 
row 4 to 6.00, and then drag row 3 to a height of 45.00. Then simultaneously 
set the width of columns F, G, and H to 10. Finally, reset the width of column B 
to fit its longest entry.
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3.2	 Merge	or	Split	Cells
Worksheets that involve data at multiple hierarchical levels often use horizontal and ver-
tical merged cells to clearly delineate relationships. With Excel, you have the following 
three merge options:

●	 Merge	&	Center	 This option merges the cells across the selected rows and columns, 
and centers the data from the first selected cell in the merged cell.

●	 Merge	Across	 This option creates a separate merged cell for each row in the 
selection area, and maintains default alignment for the data type of the first cell  
of each row of the merged cells.

●	 Merge	Cells	 This option merges the cells across the selected rows and columns, and 
maintains default alignment for the data type of the first cell of the merged cells.

In the case of Merge & Center and Merge Cells, data in selected cells other than the first 
is deleted. In the case of Merge Across, data in selected cells other than the first cell of 
each row is deleted.
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➤ To merge selected cells

➜ On the Home tab, in the Alignment group, click the Merge	&	Center button to 
center and bottom-align the entry from the first cell.

➜ On the Home tab, in the Alignment group, display the Merge	&	Center list, and then 
click Merge	Across to create a separate merged cell on each selected row, main-
taining the horizontal alignment of the data type in the first cell of each row.

➜ On the Home tab, in the Alignment group, display the Merge	&	Center list, and 
then click Merge	Cells to merge the entire selection, maintaining the horizontal 
alignment of the data type in the first cell.

➤ To split a selected merged cell

➜ On the Home tab, in the Alignment group, click the Merge	&	Center	button.

➜ On the Home tab, in the Alignment group, display the Merge	&	Center list, and 
then click Unmerge	Cells.

Practice	Tasks

The practice file for this task is located in the Excel\Objective3 practice file folder. 
If you want to save the results of the tasks, save them in the same folder with My 
appended to the file name so that you don’t overwrite the original practice file.

● On the Employees worksheet of the Hyperlink workbook, merge cells A12:C13 
so that the hyperlink is centered across the bottom of the three columns. 
Then unmerge the cells so that the hyperlink appears in only cell A12.

3.3	 Create	Row	and	Column	Titles
If a worksheet you will print spans more than one page, you can select an option to print 
the row and/or column headers, also known as the titles, on each page.
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See Also	 For	information	about	printing	alphanumeric	row	and	column	headings,	see	
section	1.2,	“Print	a	Worksheet	or	Workbook.”

➤ To print row and column titles on every page

 1. On the Page	Layout tab, in the Page	Setup group, click the Print	Titles button.

 2. On the Sheet page of the Page	Setup dialog box, in the Print	titles area, click in the 
Rows	to	repeat	at	top box. Then in the worksheet, select the row(s) containing 
the column titles you want to print on each page.

 3. Click in the Columns	to	repeat	at	left box. Then in the worksheet, select the 
column(s) containing the row titles you want to print on each page.
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Practice Tasks

The practice file for this task is located in the Excel\Objective3 practice file folder. 
If you want to save the results of the tasks, save them in the same folder with My 
appended to the file name so that you don’t overwrite the original practice file.

● In the HeightWidth workbook, configure the Inventory List worksheet to print 
the row and column headings on each page.

3.4  Hide or Unhide Rows and Columns
If parts of a worksheet contain information you don’t want to display, you can hide the 
rows or columns containing the data. Anyone who notices that column or row headings 
(column letters or row numbers) are missing can unhide the information unless you 
protect the workbook. If you don’t want to go to the trouble of enforcing protection, 
you can hide all the column and row headings in the worksheet to make the hidden 
information harder to detect.

See Also  For information about hiding the column and row headings, see “Customizing 
Worksheet Appearance” in section 4.3, “Manipulate Worksheet Views.”
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➤ To hide selected rows or columns

➜ Right-click the selection, and then click Hide.

Or

 1. On the Home tab, in the Cells group, display the Format list.

 2. In the Visibility section of the Format list, point to Hide	&	Unhide, and then click Hide	
Rows to hide the selected row(s) or Hide	Columns to hide the selected column(s).

➤ To unhide rows or columns

 1. Select the columns or rows on both sides of the hidden column(s) or row(s).

 2. Right-click the selection, and then click Unhide.

Or

 1. Select the rows or columns on both sides of the hidden rows or columns.

 2. On the Home tab, in the Cells group, display the Format list.

 3. In the Visibility section of the Format list, point to Hide	&	Unhide, and then click 
Unhide	Rows to display the selected row(s) or Unhide	Columns to display the 
selected column(s).

➤ To unhide the first row or column of a worksheet

 1. In the Name	box to the left of the Formula	Bar, enter , and then press Enter.

 2. On the Home tab, in the Cells group, display the Format list.

 3. In the Visibility section of the Format list, point to Hide	&	Unhide, and then click 
Unhide	Rows to display row 1, or Unhide	Columns to display column A.

Tip	 To	find	hidden	cells	in	a	worksheet,	click	the	Find	&	Select	button,	click	Go	To	Special,	
select	Visible	Cells	Only,	and	then	click	OK.	Cells	adjacent	to	hidden	cells	are	identified	by		
a	white	border.

Practice	Tasks

The practice file for this task is located in the Excel\Objective3 practice file folder. 
If you want to save the results of the tasks, save them in the same folder with My 
appended to the file name so that you don’t overwrite the original practice file.

● On the Inventory List worksheet of the Hiding workbook, hide the column 
containing the Inventory ID and the row containing the data’s source notes. 
Then unhide the row, but not the column.
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3.5	 Manipulate	Page	Setup	Options	for	Worksheets
You can control the layout of printed worksheets not only by defining a print area and 
inserting page breaks but also by changing the page margins, the space allocated to 
the header and footer, the page orientation, and the paper size.

See Also	 For	information	about	defining	a	print	area	and	setting	page	breaks,	see	
section	1.2,	“Print	a	Worksheet	or	Workbook.”

If none of these methods enables you to fit the required amount of information on a printed 
page, you can avoid having to adjust the font size and the width and height of columns 
and rows by scaling the worksheet to less than 100 percent. This option achieves the 
effect you want at print time but does not change the worksheet layout for people who 
will be viewing it on-screen. 

You can scale a worksheet manually or allow Excel to scale it for you by specifying the 
number of pages you want the printed worksheet to be.
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➤ To change the page margins

 1. On the Page	Layout tab, in the Page	Setup group, click the Margins button.

 2. In the Margins list, do one of the following:

❍ Click the standard margin setting you want.

❍ Click Custom	Margins, and then on the Margins page of the Page	Setup 
dialog box, specify the Top, Bottom, Left, and Right margins, and click OK.

➤ To change the height of the header and footer

 1. On the Page	Layout tab, in the Page	Setup group, click the Margins button, and 
then click Custom	Margins.

 2. On the Margins page of the Page	Setup dialog box, specify the vertical dimensions 
of the Header and Footer areas, and then click OK.

➤ To change the page orientation

➜ On the Page	Layout tab, in the Page	Setup group, click the Orientation button, 
and then click Portrait or Landscape.

➤ To scale the worksheet when printing

 1. On the Page	Layout tab, click the Page	Setup dialog box launcher.

 2. On the Page page of the Page	Setup dialog box, in the Scaling area, click Adjust	
to. Then change the %	normal	size setting.

Or

On the Page page of the Page	Setup dialog box, do one of the following:

❍ With Adjust	to selected in the Scaling area, adjust the %	normal	size setting.

❍ In the Scaling area, click Fit	to. Then specify the number of pages horizontally 
and vertically on which you want to print the worksheet.

 3. In the Page	Setup dialog box, click OK.
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Practice Tasks

The practice file for these tasks is located in the Excel\Objective3 practice file folder. 
If you want to save the results of the tasks, save them in the same folder with My 
appended to the file name so that you don’t overwrite the original practice file.

● In the Layout workbook, display the JanFeb worksheet. Ensure that all the 
contents will print in a landscape orientation on two pages of letter-size 
paper.

● In the Layout workbook, ensure that all the contents of the JanFeb worksheet 
will print on two pieces of A5-size paper.

● In the Layout workbook, ensure that the contents of the JanFeb worksheet 
will print at 50 percent of their actual size.

3.6  Create and Apply Cell Styles
You don’t have to apply cell formats one at a time. You can quickly apply several formats 
at once by clicking a style in the Cell Styles gallery. Some of the categories of styles in this 
gallery are static, whereas others are dynamic and change according to the theme applied 
to the worksheet.
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If you need a style that is not already defined, you can manually format a cell and then 
save the combination of formatting as a cell style that you can easily apply elsewhere.

 

➤ To apply a style to a selected cell

 1. On the Home tab, in the Styles group, click the Cell	Styles button.

 2. In the Cell	Styles gallery, click the style you want.

➤ To create a cell style based on a formatted cell

 1. Select a cell that has the combination of formatting you want to save as a style.

 2. In the Cell	Styles gallery, click New	Cell	Style.

 3. In the Style dialog box, name the style, clear the check boxes of any elements you 
don’t want to include in the style, and then click OK.

➤ To create a cell style from scratch

 1. In the Cell	Styles gallery, click New	Cell	Style.

 2. In the Style dialog box, enter a name for the style in the Style	name box.

 3. Click Format. In the Format	Cells dialog box, on the Number, Alignment, Font, 
Border, Fill, and Protection pages, specify the properties of the custom cell style.

 4. Click OK in each of the open dialog boxes.
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Practice	Tasks

The practice file for this task is located in the Excel\Objective3 practice file folder. 
If you want to save the results of the tasks, save them in the same folder with My 
appended to the file name so that you don’t overwrite the original practice file.

● On the Expense Statement worksheet of the FormatCells workbook, select 
cells A9:K9, and apply the 20% - Accent2 cell style. Then change the font 
style and background color of cells A9:K9, and save the formatting combina-
tion as a new cell style.

Objective	Review
Before finishing this chapter, ensure that you have mastered the following skills:

3.1 Apply and Modify Cell Formats
3.2 Merge or Split Cells
3.3 Create Row and Column Titles
3.4 Hide or Unhide Rows and Columns
3.5 Manipulate Page Setup Options for Worksheets
3.6 Create and Apply Cell Styles
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A
absolute	references	(Excel),	243

to range of cells, 250
activating	charts	(PowerPoint),	415
Active	view	(Outlook),	625
adding	values	in	worksheets,	189
add-ins	(PowerPoint),	316
address	block	(Word),	147
address	books,	591

adding members to contact groups from, 600
finding email addresses in, 484
multiple, searching, 484
printing, See printing contact records
searching, default behavior, 484
selecting contacts from, 616
Suggested Contacts, 503

address	lists.		address	books
addressing	email	messages,	484
alerts.		notifications	(email)
aligning	(Excel),	text	in	worksheet	cells,	205,	206
aligning	(PowerPoint)

graphics, 371
text boxes, 359
text in slides, 347, 349, 362
text in tables, 403

alphanumeric	index	(Outlook	Contacts	module),	
502,	503

Animation	gallery,	422
Animation	Painter,	424
Animation	pane,	428,	430

adding sound, 431
changing animation order, 431
changing effect options, 429, 431
changing timing, 431
viewing animation details, 428

animations,	slide.		slide	animations
annotating	slides,	468
Appointment	page,	for	meeting	requests,	611
Appointment	Recurrence	dialog	box,	609,	613
appointments,	604

across multiple days, 605
and events, compared, 604
and meetings, compared, 604

attaching information to, 604
availability choices, 604, 605
canceling recurrence, 609
categorizing, 512
converting to meetings, 605
creating from email messages, 606
creating from tasks, 604
entering in appointment window, 604
entering in Calendar pane, 604
forwarding, 609
forwarding as iCalendar files, 609
marking as Private, 608
notes, adding to, 605
on mobile devices, 604
printing, 610
recurring, 608
reminders, 497, 605
scheduling, 604
searching for, 531
selecting times for, 605
setting options for, 496
time, changing, 606

archiving,	mailbox	items,	509,	573
arguments,	conditional	logic	(Excel),	246
artistic	effects,	applying	to	pictures	(Word),	104
aspect	ratio	(PowerPoint)

in graphics, maintaining, 369
in text boxes, locking, 358
settings, for cropping, 374

assigning	items	to	categories	(Outlook),	514
assignments,	task

accepting, 641
declining, 642
options, changing, 504

attaching
electronic business cards, to email messages, 599
items to contact records, 596

attachments,	email.		email	attachments
attendees,	meeting.		meetings

optional, availability of, 614
optional, inviting to meetings, 613
required, availability of, 614
required, inviting to meetings, 612
sending email messages to, 619

Index



audio	(PowerPoint)
automatic play, setting, 394
clips, in slides, 392
editing, 395
fading in/out, 395
files, inserting into slides, 392, 393
hiding during show, 394
icons, 393
in slides, 392, 394
looping, 394
recording, 393
rewinding, 394
settings, changing, 394
trimming, 395
volume, changing, 394

audio/visual	equipment,	scheduling,	502
AutoArchive	(Outlook),	573
AutoComplete	(Outlook),	493
AutoCorrect	(Outlook),	487
AutoCorrect	(PowerPoint),	438

adding entries to, 439
customizing, 314

AutoCorrect	(Word),	125
adding entries to, 126
default settings, modifying, 126
exceptions, 127

AutoFill	(Excel),	193
custom data series, 194
options, 193

AutoFit	(Excel),	210
Autofit	(PowerPoint),	356

behavior, setting, 358
options, 356

AutoFormat	(Outlook),	487
Automatic	Replies	(Outlook),	579

and rules, compared, 579
out-of-office, 580
rules, specifying, 580

AutoSave	(Excel),	184
AutoSave	(Word),	28
AutoSum.		Excel	functions,	SUM
availability

in Scheduling Assistant page, 614
options for appointments, 604

Available	Windows	gallery	(Outlook),	555
averages,	calculating,	245
axes,	chart	(PowerPoint),	410

adding/removing, 412
formatting, 418

B
background.	See also	page	backgrounds	(Word);	

slide	backgrounds
email message, changing, 587
page, color, 95
page, pattern, 95
page, watermark, 95, 96

Background	Removal	tab	(pictures),	377
Backstage	view	(Excel),	168
balloons	(Word),	127,	129
banner,	web	page,	324
Bcc	field	(email	message),	544
blank	page,	83
Blocked	Senders	list	(Outlook),	582,	584
blog	posts

creating, 34
publishing, 35

booklets,	printing	contacts	as,	538
bookmarks	(Word),	135
borders	(Excel),	207
borders	(PowerPoint),	368
breaks.		page	breaks	(Excel);	page	breaks	(Word);	

section	breaks	(Word)
brightness,	adjusting	(PowerPoint),	377
broadcasting	slide	shows,	473
browsers,	278
browsing	document	elements,	53,	54,	57
Building	Block	Organizer	(Word),	90
building	blocks.		Quick	Parts	(Word)
bulleted	lists	(PowerPoint)

animating, 429
bullet style, changing, 352
changing items to/from titles, 350
converting SmartArt graphics to, 388
converting to/from paragraphs, 350, 352
creating SmartArt graphics from, 385
customizing, 350
demoting, 352
formatting, 350
indenting, 352, 353
pictures as bullets, 353
promoting, 352

bulleted	lists	(Word)
automatic formatting, turning on/off, 78
creating, 77
level, changing, 77
sorting, 77
symbol, changing, 77
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Bullets	gallery	(PowerPoint),	353
business	cards,	electronic

as email message signatures, 597
Business Card list, 598
creating contact records from, 595
custom user fields, 598
editing, 598
formatting, 598
images in, 596, 598
in contact records, 596
in email messages, 599
in email signatures, 586

buttons
Quick Access Toolbar (Excel), 182
Quick Access Toolbar (PowerPoint), 312, 313
ribbon, appearance of, xxxii
ribbon (Excel), 178
ribbon (PowerPoint), 316

C
Cached	Exchange	Mode	(Outlook),	523
calculations.		Excel	formulas
calendar	groups,	627,	628
calendar	items

appointments. See appointments
attaching to email messages, 569
canceling recurrence, 609
charts in, creating or modifying, 554
clip art, inserting, 551
grouping, 625
hyperlinks in, creating, 557
marking as Private, 608
modifying visual elements, 556
pictures, inserting, 550
recurring, 608
reminders for, default, 497
screen images, inserting, 555
shapes, inserting, 551
SmartArt graphics, creating, 552
visual elements, inserting, 550

Calendar	module
content pane in, 526
Daily Task List in, 635
defining week settings, 497
displaying list views in, 527
Free/Busy options, customizing, 498
holidays, adding, 497
new meeting time proposals on, 497

setting options for, 501
tasks in, 635
time zones, 501

Calendar	pane
displaying specific day, week, or month, 623
entering appointments in, 604
entering events in, 606
views in, 622

Calendar	view,	625
calendars

color, changing, 500, 629
controlling information displayed, 499
displaying/hiding, 626
hiding details from meeting invitees, 501
imported, 627
in content pane, 526
in Mail module (Outlook), 627
Internet subscription, 627
limiting access to, 498
meetings in. See meetings
multiple, displaying, 624, 628
permissions, controlling, 499
printing. See printing calendars
scheduling tasks in, 635
secondary, 625, 627
setting options for, 496
view modes, switching, 628

calling	contacts,	594
captions,	photograph.		photographs	(PowerPoint)
capturing	screen	clippings	(Outlook),	555
capturing	screen	clippings	(Word),	103
cards,	printing	contacts	as,	538
cascading	program	windows	(Excel),	230
cascading	program	windows	(PowerPoint),	308
catalogs,	setting	up	mail	merge	for	(Word),		

151,	155
categories	(Outlook).		color	categories	(Outlook)
category	axis,	255,	410

adding/removing, 412
formatting, 418

CDs,	packaging	presentations	for,	454
cell	ranges	(worksheet)

adding to print areas, 169
mathematical operations and, 189
pasting formula results in, 189
removing from print areas, 170
specific, moving to, 167
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cell	references.	See	Excel	formulas
cells,	table	(Word).		tables	(Word)
cells,	worksheet

aligning text, 206
borders, adding/removing, 207
Cell Styles gallery, 222
color/pattern fill, 207
comments, displaying/hiding, 286
copied or cut, inserting, 191
custom styles, creating, 223
deleting, 190, 192
error when inserting, 191
fill, applying based on cell value, 298
fill color, 207, 298
first, moving to, 167
formatting, 204. See also conditional formatting 

(Excel)
formatting, copying, 206
formatting text in, 205
inserting, 189, 190, 191
inserting comments in, 285
merging, 216
moving between, 166
nonblank, moving to next or last, 167
number formatting in, 210
splitting merged, 216
styles, creating, 223
styling, 223
text alignment, 205
text format, default, 204
text orientation, changing, 205, 206
text wrapping, 205, 206
unmerging, 216
wrapping text in, 206
zooming on, 233

character	formatting	(Excel),	204
character	formatting	(PowerPoint),	346
character	formatting	(Word),	48
character	spacing	(PowerPoint),	347
character	spacing	(Word),	48
character	styles	(Word),	51
chart	area,	410

selecting, 415
chart	axes,	410

adding/removing, 412
category, 255
data points, 255
displaying/hiding, 262
formatting, 418

series, 255
titles, adding/removing, 261
value, 255

chart	gridlines
displaying/hiding, 262
formatting, 418

chart	legends,	410
adding/removing/moving, 261, 413
formatting, 418

charts	(Excel)
axes, displaying/hiding, 262
axis, adding/removing, 261
axis titles, adding/removing, 261
category axis, 255
chart sheets, moving chart to, 258
chart type, changing, 256
chart types, listed, 254
data labels, displaying, 261
data points, 255
data range, changing, 259
data table, displaying, 262
editing data, 259
formatting elements, 263
gridlines, displaying/hiding, 262
in Outlook items, 553
layout, applying/changing, 257
legend, adding/removing/moving, 261
moving to different worksheet, 258
plotting selected data, 256
rows/columns, switching, 256
series axis, 255
size, changing, 258
styles for, 257
title, adding, 260
value axis, 255

charts	(Outlook)
creating, 554
modifying, 554

charts	(PowerPoint)
3D, formatting, 413
activating, 415
adding/removing elements, 412
analysis elements, adding/removing, 413
chart area, styling/formatting, 417, 419
chart types, 410
data source, switching, 408
editing data, 408
elements of, 410
Format dialog box for, 417, 419
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gridlines, displaying/hiding, 411, 413
inserting, 406
layout, applying/changing, 411
plot area, formatting, 417
plotting data, 408
positioning elements in, 415
rotating, 415
selecting elements, 414
size, changing, 415
styles for, 416, 418
titles, 411
WordArt styles, applying, 419

checking	addresses	(Outlook),	594
checking	spelling.		spell	checking
circles,	drawing,	382
cleaning	up	conversations	(Outlook),	490
clip	art.		graphics

background, removing, 377
brightness, adjusting, 377
color, changing, 378
compressing, 378
contrast, adjusting, 377
cropping, 374, 375
discarding changes, 379
downloading from Internet, 551
effects, applying, 377, 378
formatting, 376
inserting (Excel), 264
inserting (Outlook), 551
inserting (Word), 113
locating, 113, 551
modifying, 377
replacing, 379
saving as a file, 114
sharpening/softening, 376, 377
storing in Clip Organizer, 114, 264, 265
tinting options, 376
transparency, changing, 378
viewing information, 551

clip	art	videos,	389
inserting into slides, 390

Clip	Organizer.		Microsoft	Clip	Organizer
Clipboard.		Microsoft	Office	Clipboard
color	(Excel)

assigning to worksheet tabs, 227
cell, changing, 207
conditional formatting, 298
filtering data by, 292
scale, displaying based on cell value, 299

color	(Outlook)
calendar, changing, 629
notes icon, setting, 505
pictures, changing, 556
task, changing, 504

color	(PowerPoint)
pictures, changing, 378
SmartArt graphics, changing, 387

color	categories	(Outlook),	512
appearance of, 513
assigning email messages to, 517
assigning items to, 514
assigning notes to, 645
custom, creating, 515
default, setting, 511
keyboard shortcuts, assigning, 515
multiple, assigning items to, 514
Quick Click, 513, 515
renaming, 515

color	scheme.		colors,	theme
colors,	theme	(PowerPoint)

changing, 333, 335
creating, 334

colors,	theme	(Word),	changing,	89
column	references.		Excel	formulas
columns	(Excel)

adjusting manually, 209
aligning text in, 206
deleting, 190, 192
freezing, 228
headings, hiding/displaying, 232
headings, printing, 173
hiding, 219
inserting, 189, 191
merging, 215
selecting, 162, 209
selecting data in, 163
sizing, 162
sorting by, 294
titles, printing, 217
transposing with rows, 189
unfreezing, 229
unhiding, 219
width, changing, 208, 210
wrapping text in, 206

columns	(PowerPoint),	362,	363
columns	(Word)

aligning text, 85
changing width, 86
formatting part of a document in, 86
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columns	(Word)	(continued)
lines between, displaying, 86
multiple, formatting entire document, 85
table, deleting, 74
table, inserting, 74
table, width, 74

comma	delimited	file	(Excel),	279
command	groups	(ribbon),	179,	180
commands

accessing from minimized ribbon, 178
adding to Quick Access Toolbar, 312
old, restoring to ribbon, 180
ribbon, xxxi, 182

comments	(Excel)
appearance in worksheets, 285
deleting, 286
displaying/hiding, 285, 286
editing, 286
inserting, 285
moving, 286
moving among, 286
resizing, 286

comments	(PowerPoint)
default placement of, 436
deleting, 437
displaying/hiding, 436, 437
editing, 437
inserting, 437
moving among, 437
printing, 459
user name attached to, 436

comments	(Word)
appearance of, 127, 128
deleting, 130
displaying, 129
editing, 129
hiding, 129
inserting, 128
moving among, 129
responding to, 130
reviewing, 128

Common	Feed	List	(CFL),	511
comparing	presentations,	444
Compatibility	Checker	(PowerPoint),	449,	450
Compatibility	Mode	(Excel),	279
compressing	media	for	presentations,	453
compressing	pictures,	103,	378
conditional	formatting	(Excel)

based on cell value, 298
deleting for selected cells, 299

display options, 299
modifying for selected cells, 299
rules, creating, 299
rules, managing, 296
rules, types of, 296
stopping test if rule is met, 299

conditional	logic	arguments	(Excel),	246
conference	rooms,	scheduling	(Outlook),		

502,	615,	618
connecting	shapes	(PowerPoint),	383
contact	groups	(Outlook),	591,	500

adding to Safe Recipients list, 582
creating from existing contact records, 600
creating new contact records from, 601
creating new contacts in, 601
members, adding from address book, 600
notes, recording, 601
removing contacts, 601
updating contact information in, 601

contact	records	(Outlook),	591
addressing email messages from, 594
alphanumeric index, 502
alphanumeric indices, multiple, displaying, 503
assigning flags to, 518
assigning tasks from, 594
associating with email messages, 517
associating with notes, 646
attaching items to, 596
categorizing, 512
changing default mailing address, 596
changing filing order, 596
charts in, creating/modifying, 554
clip art, inserting, 551
creating, 594, 595
creating contact groups from, 600
creating journal entries from, 594
creating tasks from, 634
displaying maps from, 594
displaying websites from, 594
electronic business cards in, 596
filing order, 502, 503, 593
flagging, 517, 634
flags, listed, 517
hyperlinks in, creating, 557. See also hyperlinks
images in, 596
in content pane, 526
initiating actions from, 593, 594
initiating phone calls from, 594
meeting requests, creating from, 594
modifying visual elements, 556
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phone numbers in, 594
pictures in, 503
presence information in, 503
preventing creation of, 503
printing. See printing contact records
screen images, inserting, 555
searching for, 531
sending, 595
setting options for, 502
shapes, inserting, 551
SmartArt graphics, creating, 552
types of information in, 592
visual elements, inserting, 550

contacts.		contact	records	(Outlook)
addresses, mapping, 594
assigning tasks to, 594
calling, 594
display information, specifying, 503
finding quickly, 483
in groups, updating, 601
journal entries, assigning to, 594
name structure, specifying, 503
removing from contact groups, 601
tracking email messages for, 646
website, displaying, 594

Contacts	module	(Outlook).		contact	records	
(Outlook)

contact pictures in, 503
content pane in, 526
displaying list views in, 527
filing order in, 502
finding contacts in, 483
Navigation Pane in, 483
presence information in, 503
setting options for, 502

content	pane	(Outlook),	525
Calendar module views, 526
Contacts module views, 526
Mail module views, 525
Tasks module views, 526

continuous	section	breaks	(document),	84
contrast	(picture),	adjusting,	377
conventions	of	book,	xxiv
Conversation	view	(Outlook),	574
conversations	(Outlook)

cleaning up, 490
managing, 574

converting
table to text (Word), 75
text to table (Word), 67

copying	(Excel),	188
currency amounts, in worksheets, 197
formatting, 206
formatting only, in worksheets, 197
numeric data, in worksheets, 197
text, in worksheets, 197
worksheet data, 404
worksheets, 226

copying	(Outlook)
email messages, automatically. See rules (Outlook)
formatting, 561
tasks, 638

copying	(PowerPoint)
formatting, 347
slide animations, 424
slide text, 345

copying	(Word)
pictures, to new location, 104
text boxes, 116

cover	page,	inserting	(Word),	93
cropping	frame,	374,	375
cropping	handles,	375
cropping	pictures	(Outlook),	556
cropping	pictures	(PowerPoint),	374

after background removal, 377
by hand, 375
to aspect ratio, 375
to fill or fit shapes, 375

cropping	pointer,	375
CSV	file	(comma	delimited)	(Excel),	279
currency	amounts,	copying	(Excel),	197
currency	formatting	(Excel),	213
custom	slide	shows

creating, 475
delivering, 476
editing, 475

Cycle	diagrams	(SmartArt),	384

D
Daily	Task	List	(Outlook),	635
data	(Excel).		data	series	(Excel)

editing, setting options for, 176
filtering, 289, 291
moving, setting options for, 176
sorting, 293

data	bars	(Excel),	299
data	entry	(Excel),	164
data	labels	(Excel),	261
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data	labels	(PowerPoint),	413
data	markers	(PowerPoint),	410,	418
data	points	(Excel),	255
data	range,	changing	for	charts	(Excel),	259
data	regions,	moving	in	(Excel),	167
data	series	(Excel),	193

AutoFill, 193, 194
capitalization in, 196
custom, creating/applying, 196
date, 193
date, advanced options, 196
date, filling, 195
day, advanced options, 196
day, filling, 195
excluding formatting when filling, 196
growth, 193
increasing/decreasing, 195
linear, 193
numeric, advanced options, 196
numeric, filling/formatting, 195

data	tables	(PowerPoint),	411
formatting, 418

data	values,	filtering	by	(Excel),	292
Date	Navigator	(Outlook)

date range, changing, 524
dates, selecting in, 524
displaying specific day, week, or month, 624
in To-Do Bar, 524
secondary calendars in, 625
week numbers in, 500
weeks, displaying, 524

date	range	in	Date	Navigator,	changing,	524
date	series	(Excel),	193

advanced options, 196
filling, 195

date/time
in Date Navigator, changing (Outlook), 524
in headers/footers (Word), 99

day
displaying in Calendar pane, 623
displaying in Date Navigator, 624

day	series	(Excel)
advanced options, 196
filling, 195

Day	view	(Outlook),	622
events in, 606
scrolling in, 624

decreasing	indentation	level	(PowerPoint),	349
delaying	delivery	of	email	messages,	517
deleted	items,	retaining	on	exit	(Outlook),	509

Deleted	Items	folder	(Outlook)
emptying, 573
viewing size of, 573

deleting	(Excel)
cells, 190, 192
rows/ columns, 190, 192

deleting	(Outlook)
calendar groups, 628
email messages, automatically. See rules (Outlook)
junk mail, automatically, 584
Outlook items, permanently, 573
rules (Outlook), 579
tasks, 642, 643

deleting	(PowerPoint)
comments, from presentations, 437
graphics with attached hyperlinks, 372
shapes, 386
table columns/rows, 400
tables, 399

delimited	text	file	(Excel),	279
delivery	receipt	(email),	requesting,	517,	543
demoting	sections,	in	Outline	view,	14
deselecting	text	(Word),	2
Design	contextual	tab	(Chart	Tools),	411
Design	contextual	tab	(SmartArt),	367

adding shape/texts from, 385
changing color/layout from, 387
converting graphics from, 388
converting graphics to independent shapes, 388
moving shapes from, 386
promoting/demoting from, 386
resetting shapes from, 388
switching direction from, 387
ungrouping graphics from, 388

Design	contextual	tab	(Table	Tools)
creating styles from, 403
drawing tables from, 400
editing chart data from, 408
erasing table borders, 401
Quick Styles, applying from, 403
switching chart data source from, 408
table columns, adding, 400

desktop	alerts,	customizing	(Outlook),	489
Developer	tab	(Word),	displaying,	43
diagrams.		SmartArt	graphics
dictionary,	adding	a	word	(Word),	123
digital	signatures	(PowerPoint)

attaching, 465
removing, 466
viewing, 465
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dismissing	reminders,	529
distributing	graphics	(PowerPoint),	371
dividing	values	(Excel),	189
Document	Information	Panel	(Excel),	183
Document	Inspector	(PowerPoint),	462
documents

AutoSave, changing frequency, 28
blank page, inserting, 83
blog posts, creating/publishing as, 34, 35
bookmarks, inserting, 135
bookmarks, moving to, 135
breaking lines, 81
Building Block Organizer, 90
bulleted lists, creating, 77
bulleted lists, formatting, 77, 78
bulleted lists, sorting, 77
character formatting, applying, 48
character spacing, changing, 48
character styles, applying, 51
clip art, locating/inserting, 113
clip art, storing, 114
columns in, 85, 86
comments. See comments (Word)
cover page, inserting, 93
demoting/promoting sections, 14
diagrams. See SmartArt graphics
drawing canvas, opening, 106
editing, restricting, 25
expanding/collapsing sections/subdocuments, 14
fields, inserting, 93
font size, changing, 48
fonts, changing, 89
footnotes/endnotes, creating, 137, 138
formatting, copying, 52
formatting, replacing, 56
formatting, restricting, 25
formatting marks, displaying/hiding, 16
formatting text, 49
grammar checking, 123. See also grammar 

checking
grammar errors, fixing, 122
grammar errors, hiding, 123
grammar errors, ignoring, 122
headers/footers, 96, 99
headings, displaying, 53
headings, moving to, 53
hidden characters, displaying/hiding, 16
highlighting search results, 56
highlighting text, 48
hyperlinks, inserting, 133, 134

hyphenation, 81
jumping to a page/section, 10
locating elements, 56, 57
mail merge. See mail merge
marking as final, 23
moving around in, 3
multiple columns, 85
navigating, 3
navigating pages, Full Screen Reading view, 10
opening in multiple windows, 20, 21
page background color, adding, 95
page backgrounds, 94
page border, adding, 94
page breaks, 82, 83
page margins, changing, 81
page settings, 80
page thumbnails, displaying, 6
pages, displaying, 54
pages, moving to, 54
paragraph indentation, changing, 59
paragraphs, applying a style, 51
paragraphs, line spacing, 63
password, 26, 27
pictures in, applying artistic effects, 104, 105
program windows, arranging multiple, 21
promoting/demoting sections, 14
protection, removing restrictions, 25
Quick Parts, 90, 92
Quick Styles, applying, 51
Quick Table, inserting, 69
removing splits, 19
reorganizing in Outline view, 14
restrictions, removing, 25
rulers, displaying/hiding, 16
saving, as PDF files, 41
saving, as XPS files, 41
saving, specific format, 40
saving to SharePoint, 32
saving to Windows Live SkyDrive, 32
screen clipping, 103
section breaks, 83, 85
sending as email attachments, 30
shapes. See shapes
shared, sending link to, 30
soft page breaks, 82
spaces, hiding/displaying, 6
special effects, adding to text, 48
spell checking, 123. See also spell checking (Word)
splitting, 19
stacking shapes/text boxes, 108

	 documents	 	 659



documents	(continued)
style area pane, displaying, 51
styles, clearing instances, 52
styles, displaying/hiding in Draft view, 15
styles, displaying/hiding in Outline view, 13
Styles pane, 51
subdocuments, opening, 14
tab stops, 61
tab stops, changing position, 61
tables. See tables (Word)
tables of contents, creating custom, 140, 141
templates, attaching, 43
text, replacing, 56
text boxes. See text boxes (Word)
text case, changing, 48
themes, 87, 88
versions, 28
versions, deleting/displaying, 28, 29
view options, Full Screen Reading view, 10
views, switching, 6
watermarks, adding, 94, 96
WordArt objects. See WordArt objects
zooming, 18

domains,	email.		email	domains
Drafts	folder	(Outlook),	492
Draft	view	(Word)

style area pane, displaying/hiding, 15
drag-and-drop	editing	(PowerPoint),	345,	346
drawing	canvas,	opening	(Word),	106
drawing	guides	(PowerPoint),	359
drawing	on	slides,	468
drawing	shapes	(Excel),	267
drawing	shapes	(PowerPoint),	382
drawing	tables	(PowerPoint),	399
drawing	tables	(Word),	67
due	date	for	tasks	(Outlook),	504,	638

E
editing	(Outlook)

electronic business cards, 598
email messages, 487
hyperlinks, 558
journal entries, 649
recurring calendar items, 609

editing	(PowerPoint)
audio, 395
comments, 437
graphics with attached hyperlinks, 372
photo albums, 322

shapes, 382
tables, 399
text, 345
videos, 392

editing	(Word),	restricting	changes,	25
effects	(Outlook),	567

applying to pictures, 556
text, changing, 560
theme, changing, 567

effects	(PowerPoint)
animation. See slide animations
applying to graphics, 368
applying to pictures, 377, 378
applying to text boxes, 361, 362
applying to WordArt text, 381
as email message signatures, 597
attaching to email messages, 599
Business Card list, 598
creating contact records from, 595
custom user fields, 598
editing, 598
embedding in email messages, 598
formatting, 598
images in, 596, 598
in contact records, 596
in email signatures, 586
theme, creating, 334

email	accounts
in Junk E-Mail Options dialog box, 582
multiple, and Quick Steps, 546
multiple, signatures in, 585, 586
specifying for sending messages, 544

email	addresses
adding to Safe Recipients list, 584
adding to Safe Senders list, 584
AutoComplete list, clearing, 493
default, in contact records, changing, 596
directing replies to, 517, 543
Exchange Server network and, 484
finding from address book, 484
multiple, sending email messages to, 484
semicolons in, 484
suggestions displayed by Outlook, 484

email	aliases,	484
email	attachments,	569

attaching multiple files, 569
creating contact records from, 596
documents, sending a link to, 30
documents, sending as, 30
electronic business cards as, 599
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encrypting, 516
forwarding, 569
linking to shared documents, 30
multiple, saving, 575
opening, 569
Outlook items as, 569
previewing, 569
printing, 535
processing messages based on, 576
recording in Outlook Journal, 648
saving, 569, 575
workbooks as, 284

email	domains
adding to Safe Recipients list, 584
adding to Safe Senders list, 582, 584
blocking, 584
top-level, blocking, 585

email	messages
adding signatures, 517
addressing, 484
advanced editing features, 488
appearance, changing, 542, 587
archiving, 573
arrival notification, customizing, 489
assigning flags to, 518
associating with contact records, 517
attaching electronic business cards to, 599
attachments. See email attachments
AutoCorrect options, 487
AutoFormat options, 487
Automatic Replies, 579
backgrounds, changing, 587
Bcc field, displaying/hiding, 544
business graphics in, 551
categorizing, 512, 517, 576
charts in, creating/modifying, 554
clip art, inserting, 551
colors, changing, 587
commenting on, 491
conversations, cleaning up, 490
conversations, ignoring, 575
creating appointments from, 606
creating contact records from, 595
creating events from, 607
creating from contact records, 594
creating tasks from, 634
cut/paste options, customizing, 488
deleting, and flags, 634
deleting permanently, 573
delivery, delaying, 517

delivery, scheduling, 543
delivery options, changing, 542
delivery receipt, requesting, 495, 517, 543
drafts, 492
drafts, customizing save options, 492
Drafts folder, 492
editing options, setting, 487
embedding electronic business cards in, 598
encrypting, 516
expiration, setting, 517, 544
flagged, 634, 642
flagging, 517, 634
fonts, changing, 587, 588
format, setting, 487
formatting, 587
formatting in plain text, 542
formatting in Rich Text Format (RTF), 542
forwarding, 490, 491
From field, displaying/hiding, 544
graphics in, 551
header fields, 493, 544
headers, content of, 482
headers only downloaded, 482
HTML, 487
hyperlinks in, creating, 557. See also hyperlinks
importance, setting/removing, 516
information bar in, 581
inline responses, 491, 589
Internet headers, displaying, 517
junk. See junk mail
languages, blocking, 585
Math AutoCorrect options, 487
measurements in, customizing, 488
meeting requests, keeping after response, 493
modifying visual elements, 556
moving, and flags, 634
notification requests, processing, 495
options, setting/changing, 542
outgoing, flagging for follow-up, 518
out-of-office replies, creating, 580
Overtype mode in, 488
participants, shown in People Pane, 522
pictures in, 503, 550, 556
plain text, 487, 542
poll, creating, 543
presence information in, 503
printing, 535
printing list views of, 535
priority, setting/removing, 516
processing automatically. See rules (Outlook)
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email	messages	(continued)	
Properties dialog box, displaying, 517
Quick Steps and. See Quick Steps (Outlook)
reading without opening, 482
read receipts, requesting, 489, 495, 517, 543
read status, setting, 519
receipts, requesting, 493, 495, 543
receiving, 482
recipients, processing based on, 576
recording in Outlook Journal, 648
redundant, deleting, 574
replies, automatic. See Automatic Replies (Outlook)
replies, routing to different email address, 543
responses, customizing, 490
responses, including original text in, 491
Rich Text Format (RTF), 487, 542
rules. See rules (Outlook)
Safe Senders list, 582, 584
saving, 545, 575, 576
screen images, inserting, 555
Search Folders, 533
search results, working with, 532
searching for, 531, 532
send/receive options, accessing, 511
senders, blocking, 582, 584
senders, processing based on, 576
senders, scheduling meetings with, 616
sending, 544
sending from different accounts, 544
sending to meeting attendees, 619
sending to multiple recipients, 484
send/receive status, viewing, 528, 530
sensitivity, setting, 516
sent, saving, 492, 545
sent items, customizing save options, 492
Sent Items folder, 492
shapes, inserting, 551
SmartArt graphics in, 551
spell checking, customizing, 488
stationery, 587
styles, changing, 587
text, customizing how Outlook works with, 488
theme, default, 566, 587
to recipients not using Outlook, 542
tracking, 495, 646
unread, viewing number of, 528
viewing text of, 482
visual elements, inserting, 550
voting buttons, 517, 543

email	signatures,	585
creating, 586
electronic business cards, 597
in responses, 587
inserting manually, 587
removing, 587

embedding	electronic	business	cards	in	email	
messages,	598

emptying
Deleted Items folder, 573
Junk E-Mail folder, 582

encrypting	email	messages,	516
encrypting	presentations,	464
endnotes	(Word)

creating, 137
deleting, 138
formatting, 138

envelopes	(Word),	addressing	using	mail	merge,	
149,	154

environment.		working	environment
erasing	slide	annotations,	469
erasing	table	borders,	401
errata,	submitting,	xli
error	checking,	options	for	(Excel),	176
Even	Page	section	break	(Word),	84
events	(Outlook)

appearance in Calendar, 606
appointments and, compared, 604
canceling recurrence, 609
creating, 607
entering in Calendar pane, 606
entering in event window, 606
forwarding, 609
marking as Private, 608
printing, 610
recurring, 608, 609
reminders for, default, 497
selecting dates for, 607

event	window	(Outlook),	606,	607
Excel	97-2003

opening .xlsx files in, 278
.xls file format, 278, 279

Excel	2010.		worksheets
advanced options, setting, 176
AutoFill feature, 193
charts, in Outlook items, 553
Compatibility Mode, 279
opening multiple windows, 229
Paste Special dialog box, 188
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program window, 176, 230, 231
ribbon, customizing, 178
saving workbooks in other formats, 278
workbook formats, 278
working environment, managing, 165
.xlsb file format, 278
.xlsm file format, 278
.xlsx file format, 278

Excel	formulas.		Excel	functions
average of a range, 238
calculation, changing order in, 241
cell reference range, absolute, 250
cell reference range, relative, 250
cell references, absolute, 243
cell references, relative, 242
cell references, relative to range in formula, 250
column references, absolute, 243
conditional logic arguments, 246
counting cells with values, 238
counting empty cells, 238
highest value in a range, finding, 239
lowest value in a range, finding, 239
named ranges, changing name, 249
named ranges, defining, 248, 249
named ranges, deleting, 249
nesting functions, 246
options for, 176
results, pasting, 189
sum of values in range, 237
worksheet references, different workbook, 244
worksheet references, same workbook, 243

Excel	functions
AVERAGE, 238
AVERAGEIF, 245
AVERAGEIFS, 245
COUNT, 238
COUNTA, 238
COUNTIF, 245
COUNTIFS, 245
IF, 246
IFERROR, 245
MAX, 239
MIN, 239
nesting, 246
SUM, 237
SUMIF, 245
SUMIFS, 245

Excel	Macro-Enabled	Workbook,	278

Excel	Options	dialog	box,	175
Advanced page, 176
Formulas page, 176
Quick Access Toolbar page, 181

Exchange	Server
connecting to account, 530
connection status, viewing, 528
email addresses on, 484
MailTips, in Outlook, 494
notes in, 644
Outlook Cached Exchange mode and, 523
Outlook People Pane limitations and, 523
rules, applying to multiple accounts, 578
rules, setting up, 576
scheduling meetings and, 614

expanding	ribbon,	179
expiration	(email	messages),	setting,	517
exporting

content from Outlook, 510
RSS feeds from Outlook, 510

F
feedback,	submitting,	xli
Field	Chooser	(Outlook),	528
fields,	inserting	(Word),	93
fields,	list	view	(Outlook)

adding, 528
removing, 528

file	formats	(Excel),	278,	279
file	formats	(PowerPoint),	448
files

linking graphics to, 373
worksheet hyperlinks to, creating, 200

filing	order,	contacts	(Outlook),	502
filling	data	series	(Excel),	193

custom, 194, 196
excluding formatting, 196

filtering	data	(Excel),	289,	290
applying a common criterion, 292
by data values, 292
by formatting, 292
for a specific column value, 291
removing, 291

filters	(Excel)
custom, creating, 292
filter buttons, 291
filtering arrows, displaying/hiding, 292
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finding/replacing	text	(PowerPoint),	441
flags	(Outlook)

adding reminders to, 518
assigning, 518, 634
custom, setting, 518
for email recipients, 518
for outgoing messages, 518
reminders for, 517
removing, 642

Folder	List,	accessing	(Outlook),	525
folders	(Outlook)

creating, 483
task, 637

fonts	(Excel),	worksheet,	conditional	formatting,	
298

fonts	(Outlook)
changing, 560
color, changing, 560
email message, changing, 587
for specific email message types, 588
size, changing, 560
style, changing, 560

fonts	(PowerPoint)
replacing, in presentations, 442
theme, changing, 334, 335
theme, creating, 334
theme, deleting, 335

fonts	(Word)
theme, changing, 89
theme, deleting, 89

footers	(Excel),	174
changing, 175
height, changing, 221
inserting, 174

footers	(PowerPoint),	338
footers	(Word)

creating/modifying, 96
date/time, inserting, 99
deleting, 99
Different First Page, 98
Different Odd & Even Pages, 98
inserting, 98
page numbers in, 99
setting for sections, 84

footnotes	(Word),	137,	138
Format	contextual	tab	(audio),	394
Format	contextual	tab	(Chart	Tools),	414,	419
Format	contextual	tab	(graphics),	369,	371
Format	contextual	tab	(pictures),	375,	377,	378,	379
Format	contextual	tab	(shapes),	382,	383
Format	contextual	tab	(SmartArt),	367,	387,	388

Format	contextual	tab	(video),	391
Format	contextual	tab	(WordArt),	381,	382
Format	Painter	(Excel),	206
Format	Painter	(Outlook),	561
Format	Painter	(PowerPoint),	347,	350
Format	Painter	(Word),	52
formatting	(Excel).		conditional	formatting	(Excel)

cells, 204, 298
chart elements, 263
copying, 206
copying only formatting, 197
currency, 213
filtering by, 292
number. See number formatting (Excel)
shapes, 268, 383
text in shapes, 268

formatting	(Outlook)
applying from Paste Options button, 564
copying, 561
creating new styles from, 563
electronic business cards, 598
email messages, 487, 542, 587
local, applying, 560
notes, 644

formatting	(PowerPoint)
3D charts, 413
adjusting text layout, 362
audio icons, 394
charts, 417, 419
graphics, 366, 369
gridlines, 418
shapes, 358, 360, 361, 362
tables, 402
text, 346
videos, 391

formatting	(Word)
bulleted lists, automatic (Word document), 77
copying, 52
footnotes/endnotes, 138
locating, 56
marks, displaying/hiding, 16
page numbers in headers/footers, 99
restricting changes, 25
restrictions, removing, 25
shapes, 107
text, 49
text boxes, 116, 117
text in shapes, 107
WordArt objects, 109

Formula	Bar,	hiding/unhiding	(Excel),	232
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formulas.	See	Excel	formulas
forwarding	email	messages,	automatically.		

	rules	(Outlook)
framing	slides,	459
freezing	columns/rows	(Excel),	228
From	field	(email	message),	displaying/hiding,	544
Full	Screen	Reading	view	(Word),	10
Full	Screen	view	(Excel),	231
functions.		Excel	functions

G
Go	To	(Word)

bookmarks, 135
document elements, 57

Go	To	Special	(Excel),	166,	167
grammar	checking

AutoCorrect options, 125
email messages, 488
entire document, 123
options, setting, 124

graphics
aligning, 371
applying borders to, 368
applying effects to, 368
applying SmartArt picture layouts to, 370
applying styles to, 367
bringing forward in stack, 370
distributing, 371
dragging, 369
flipping vs. rotating, 368
formatting in Outlook items, 561
grouping, 371
hyperlinks attached to, 372
in junk mail, 581
in slides, animating. See slide animations
linked, creating ScreenTip for, 373
linking, 373
manipulating, 366
moving, 369
proportional sizing, 369
regrouping, 371
rotating, 368, 369
saving slides as, 450, 451
scale, changing, 369
selecting in a stack, 370
sending backward in stack, 370
sizing, 369
SmartArt. See SmartArt graphics
stacking order, 370
ungrouping, 371

greeting	line,	inserting,	148
gridlines

chart, displaying/hiding (Excel), 262, 411, 413, 418
displaying (Word), 16
displaying in tables (Word), 71
displaying/hiding (Excel), 232
displaying/hiding (PowerPoint), 368, 369
formatting (PowerPoint), 418
printing (Excel), 173
sizing grid, 359

grouping
calendar items (Outlook), 625
graphics (PowerPoint), 371
shapes (Word), 108
tasks (Outlook), 635, 636, 637
worksheets, 227

groups,	ribbon
displaying all commands in, xxxii
displaying hidden, xxxii

growth	data	series	(Excel),	193

H
handout	master,	customizing,	461
Handout	Master	view	(PowerPoint),	302
handouts,	changing	orientation	(PowerPoint),	325
handouts,	creating/printing	in	Word,	459,	460
header	row,	specifying	in	table	(Word),	71
headers	(Word)

creating, 96
date/time, inserting, 99
deleting, 99
Different First Page, 98
Different Odd & Even Pages, 98
inserting, 98
modifying, 96
page number, 99
setting for sections, 84

headers	(Excel),	174
changing, 175
height, changing, 221
inserting, 174

headings	(Word),	53
hidden	cells,	finding	(Excel),	219
hidden	characters,	displaying/hiding	(Word),	16
hidden	columns,	sorting	on	(Excel),	294
hidden	panes,	displaying	(PowerPoint),	310
hidden	slides,	displaying,	332,	341
hidden	worksheets,	displaying,	227
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hiding
calendar details from meeting invitees, 501
columns/rows (Excel), 219
comment (PowerPoint), 436, 437
Excel program window elements, 231
Formula Bar (Excel), 232
gridlines (Excel), 232
nonprinting characters (Word), 83
note modification date (Outlook), 505
panes (PowerPoint), 310
ribbon tabs, 179
slides, 332
worksheets, 226

Hierarchy	diagrams	(SmartArt),	384
subordinate points in, 386

highlighter	tool	(PowerPoint),	468,	469
highlighting	(Word)

search results, 56
text, 48

holidays,	adding	to	calendar,	497
.html	file	format	(Excel),	278
hyperlinks.		linking

changing target of, 558
creating pre-addressed email messages, 134, 558
default behavior, 557
editing, 558
formatting, 333
in Excel. See worksheet hyperlinks
in junk mail, treatment of, 581
inserting/modifying, 133, 134
removing, 559
testing, 373
to bookmarks, 558
to files, 557
to headings, 133
to webpages, 133, 558
to Word documents, 557

Hypertext	Markup	Language	(HTML),	email	
messages	in,	487

hyphenation	(Word),	80,	81

I
iCalendar	files,	attaching	to	email	messages,	609
Icon	view	(Outlook),	644
icons	(Excel)

displaying based on cell value, 299
ignoring	conversations	(Outlook),	575
illustrations.		clip	art;	pictures

images.	See	also	graphics;	pictures
in contact records, 596
in electronic business cards, 596, 598

Import	And	Export	wizard	(Outlook),	510
importance	(email	message),	516
importing	content	into	Outlook,	510
Inbox

cleaning up, 574
Conversation view, 574
managing conversations in, 574
new messages in, 482
searching specific folders, 532

increasing	indent	level	(PowerPoint),	349
indentation,	changing	(Word),	59
inline	responses	(email	messages),	adding	

identifiers,	491,	589
inserting	(Excel)

cells, 189, 190, 191
clip art, 264
comments in cells, 285
copied or cut cells, 191
rows/columns, 189, 191

inserting	(Word)
bookmarks, 135
cells in tables, 74
footnotes/endnotes, 137
headers/footers, 98
hyperlinks, 133
page numbers, 99
pictures, 103
screen clipping, 103
tables, 66
text boxes, 115, 116

inserting	hyperlinks	(Outlook),	557
instant	messages,	replying	to	email	messages		

with,	594
Instant	Search	(Outlook),	531,	532
Internet	fax,	sending	workbooks	as	(Excel),	283
Internet	headers,	displaying	(Outlook),	517
inviting	attendees	to	meetings,	612

J
journal	entries

assigning properties to, 649
assigning to contacts, 594
categorizing, 512
editing, 649
opening, 649
recording automatically, 505
searching for, 531
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Journal	module	(Outlook).	See also	Outlook	
Journal;	journal	entries

displaying, 647
Navigation Pane in, 483
setting options for, 505, 648

Junk	E-Mail	folder,	581,	582
junk	mail,	581

adding addresses to Safe Recipients list, 584
adding domains to Safe Senders list, 582, 584
adding groups to Safe Recipients list, 582
allowing messages from safe senders, 582, 584
allowing responses to sent mail, 584
appearance of, 581
blocking, 584, 585
deleting automatically, 584
graphics in, 581
hyperlinks in, 581
information bar in, 581
marking as Not Junk, 582
options, setting, 582
phishing messages, appearance of, 581
processing, 582
protection level, setting, 584

justifying	slide	text,	349

K
keyboard	shortcuts

assigning to color categories (Outlook), 515
navigation (Word), 3

keywords	(Excel),	183
keys,	directional

navigating documents, with, 3
navigating worksheets with, 166

L
labels

creating using mail merge, 150
creating using Mail Merge wizard, 154

landscape,	aspect	ratios	for	cropping,	374
language

blocking email based on, 585
changing (PowerPoint), 315
setting options for (Outlook), 506

Last	7	Days	view	(Outlook),	644
changing arrangement in, 645

Layout	contextual	tab	(Chart	Tools),	412,	413,	415
Layout	contextual	tab	(Table	Tools),	400,	401,	403

layout	of	diagrams,	changing,	111
legends.		chart	legends
levels,	displaying	in	Outline	view	(Word),	13
line	charts,	elements,	adding/removing,	413
line	spacing,	changing	(Word),	63
linear	data	series	(Excel),	193
lines,	breaking	automatically	(Word),	81
linked	graphics,	creating	ScreenTips	for,	373
linking.		hyperlinks

graphics to different presentations or files 
(PowerPoint), 373

graphics to different slides (PowerPoint), 373
graphics to email message form (PowerPoint), 373
graphics to webpages (PowerPoint), 373
text boxes (Word), 116
to workbooks, 284
worksheet cells, 188

List	diagrams	(SmartArt),	384
List	view	(Outlook),	625
list	views	(Outlook),	527

adding fields, 528
Calendar module, displaying, 527
Contacts module, displaying, 527
Mail module, displaying, 527
modifying, 527
Notes module, displaying, 527
removing fields, 528
resetting to default, 528
saving, 528
sorting content, 527
Tasks module, displaying, 527

lists.		bulleted	lists
local	template,	attaching	to	documents	(Word),	43
Location	Information	dialog	box	(Outlook),	594
locking	aspect	ratio	of	graphics	(PowerPoint),	369

M
magnification.		zooming
mail	merge

address block, inserting, 147
catalog/directory, 151
envelopes, addressing, 149, 150
errors, checking for, 156
greeting line, inserting, 148
into document, 159
into email message, 159, 160
labels, creating, 150
Mail Merge wizard, for catalog/directory, 155
Mail Merge wizard, for email messages, 153
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mail	merge	(continued)
Mail Merge wizard, for envelopes, 154
Mail Merge wizard, for labels, 154
Mail Merge wizard, for letters, 152
main document, multiple merge fields, 147
main document, preparing, 146
main document, single merge field, 147
manual process, 148
previewing results, 158
printing using Mail Merge wizard, 160
recipients, creating list, 145
recipients, excluding, 159
recipients from contacts, 146
recipients from file, 145
setting up for email messages, 149
setting up for letters, 148
validating, 156

Mail	module	(Outlook)
content pane in, 525
displaying list views in, 527
flagging email messages in, 634
Navigation Pane in, 525
setting options for, 486, 488- 490, 492, 494,  

495, 496
mailbox	(Outlook)

archiving items, 573
Deleted Items folder, 573
locating large items, 572
locating old items, 572
searching, 531
size, managing/viewing, 572

Mailbox	Cleanup	tools	(Outlook),	572
mailing	lists,	adding	to	Safe	Recipients	list	

(Outlook),	582
MailTips	(Exchange	Server),	preferences,	setting	in	

Outlook,	494
mapping	contact	addresses,	594
margins

of documents, 81
of slide text, 362, 363
of table cells (PowerPoint), 403
of worksheets, 221

marking	documents	as	final,	23,	24
marking	email	messages	as	read/unread,	519
marking	presentations	as	final,	465
masters,	viewing	(PowerPoint),	302,	306
Math	AutoCorrect	options	(Outlook),	487
mathematical	operations	(Excel),	189
Matrix	diagrams	(SmartArt),	384
meeting	requests,	611

accepting, 618
Appointment page, 611
attaching information to, 611

creating from contact records, 594
declining, 618
keeping, after response, 493
optional attendees, 611
processing, 495
proposing a new time, 497, 618
recording in Outlook Journal, 648
responding to, 617
response options, 612, 613, 617
responses, tracking, 619
Scheduling Assistant page, 611
tentatively accepting, 618

meeting	window	(Outlook)
canceling meetings in, 619
changing meetings in, 619
responses in, 618

meetings
accepting proposed time change, 621
adding attendees to, 613
and appointments, compared, 604
attendees, inviting, 612, 613
canceling, 620
canceling recurrence, 609
converting appointments to, 605
declining proposed time change, 621
hiding calendar details from invitees, 501
marking as Private, 608
preventing new time proposals, 498, 620
recurring, creating, 608, 613
recurring, editing, 609
recurring, updating, 620
resources, scheduling automatically, 502
response options, setting, 620
scheduling, 616. See also Scheduling Assistant
scheduling, and Exchange Server, 614
Scheduling Assistant options, changing, 501
scheduling conference rooms, 615, 618
scheduling presentation equipment, 615, 618
scheduling with a message sender, 616
sending email messages to attendees, 619
setting options for, 496
Smart Scheduling, 616
time proposal options, changing, 498
updating, 613, 620

members	of	contact	groups,	adding	from	address	
book,	600

memos,	printing	contacts	as,	539
merge	fields	(Word)

inserting address block, 147
inserting greeting line, 148
inserting multiple, 147
inserting single, 147
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merged	worksheet	cells,	splitting,	216
merging	documents.		mail	merge
merging	table	cells	(PowerPoint),	401
merging	worksheet	cells,	215,	216
Microsoft	Certification	ID,	xxi
Microsoft	Certified	Professional	website,	xxi
Microsoft	Clip	Organizer,	114,	265
Microsoft	Exchange	Server.		Exchange	Server
Microsoft	Office	2010.		Office	2010
Microsoft	Office	Clipboard,	114

saving formatting to (Outlook), 561
Microsoft	Office	Communicator.		Office	

Communicator
Microsoft	Office	Open	XML	Formats.		.xml	file	

format
Microsoft	Office	Specialist	Expert	(MOS	Expert),	xix
Microsoft	Office	Specialist	(MOS),	xix
Microsoft	Office	Specialist	program,	xx
Microsoft	Outlook	2010.		Outlook	2010
Microsoft	PowerPoint	2010.		PowerPoint	2010
Microsoft	PowerPoint	Viewer,	454
Microsoft	SharePoint	Server.		SharePoint	Server
Microsoft	Word	2010.		Word	2010
minimizing	ribbon,	178
mobile	devices,	appointment	reminders	on,	604
modules	(Outlook),	switching	between,	525,	526
monochrome	presentations,	458
month,	displaying	(Outlook),	623,	624
Month	view	(Outlook)

changing detail level, 623
events in, 606
scrolling in, 624
week numbers in, 500

motion	path	slide	animations,	422,	426
adjusting, 427
rotating, 427
schematics of, 426

moving
charts to chart sheet (Excel), 258
charts to different worksheet (Excel), 258
email messages, automatically. See rules (Outlook)
graphics (PowerPoint), 369
pictures (Word), 104
shapes (PowerPoint), 386
slide text, 345
tasks (Outlook), 637
text boxes (PowerPoint), 357, 358
worksheets, 226

multiple	columns	(Word).		columns	(Word)
multiplying	values	in	worksheets,	189

N
name	structure	of	contacts,	specifying,	503
named	ranges	(Excel)

changing name, 249
defining, 248
deleting, 249
redefining, 249
specific, moving to, 167
worksheet hyperlinks to, creating, 200

narrating	presentations,	471
narrations,	attaching	to	slides,	393
national	holidays,	adding	to	calendar,	497
navigating

among comments in presentations, 437
in documents, in Full Screen Reading view, 10
in documents, with directional keys, 3
in documents, with scroll bars, 3
in presentations, 303
in worksheets, 166

Navigation	Pane	(Outlook)
buttons, changing order, 508, 521
buttons, changing space for, 521
buttons, displaying/hiding, 507, 521
changing font in, 508
closing, 520
customizing, 520
displaying, 520
expanding, 521, 525
in Outlook modules, 482, 483
minimized, information on, 525
minimizing, 521
multiple calendars in, 626
switching between modules from, 525
width, changing, 521

Navigation	Pane	(Word)
browsing, 53, 54, 57
locating formatting, 56
locating special characters, 56
locating styles, 56
locating text, 55
page thumbnails, displaying, 6

New	Slide	gallery	(PowerPoint),	326
Next	Page	section	break	(Word),	84
nonbreaking	spaces	(Word),	81
nonprinting	characters,	displaying/hiding		

(Word),	83
Normal	view	(Excel),	231
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Normal	view	(PowerPoint),	302,	310
adjusting pane size, 310
hiding panes, 310
Notes pane, 310
Overview pane, 310
panes in. See panes (PowerPoint)
presentation sections in, 340
rearranging slides in, 331
setting transitions in, 432
Slide pane, 310
switching to, 306

notes	(Outlook)
adding to appointments, 605
assigning to categories, 645
associating with contact records, 646
attaching to email messages, 569
categorizing, 512, 645
creating tasks from, 634
default font, setting, 505
Exchange Server and, 644
filtering, 644
formatting, 644
Icon view, 505, 644
Last 7 Days view, 644
modification date, hiding, 505
Notes List view, 644
organizing, 645
recording for contact groups, 601
searching for, 531
setting options for, 505
sorting, 644
viewing, 644

notes	(PowerPoint).		speaker	notes	(PowerPoint)
Notes	List	view	(Outlook),	644

changing arrangement in, 645
notes	master,	customizing	(PowerPoint),	461
Notes	Master	view	(PowerPoint),	302
Notes	module	(Outlook)

displaying list views in, 527
Navigation Pane in, 483
setting options for, 505, 648
view, changing, 644

Notes	Page	view	(PowerPoint),	302
displaying, 461

Notes	pane	(PowerPoint),	310
notifications	(email)

customizing, 489
processing requests, 495

number	formatting	(Excel)
automatic, 210
changing, 210
custom, 211, 212
default, applying, 213
refining, 213

numbered	lists	(PowerPoint)
converting to/from paragraphs, 353
customizing, 351
demoting items, 352
indenting, 352, 353
number style, changing, 353

Numbering	gallery	(PowerPoint),	353
numbers,	appearance	in	Excel,	163
numeric	data,	copying	(Excel),	197
numeric	data	series	(Excel)

advanced options, 196
filling, 195
filling/formatting, 195

O
objective	domain,	in	MOS	exams,	xx
objects	(Word)

clip art, locating/inserting, 113
WordArt, creating from text, 109
WordArt, formatting, 109
WordArt, inserting, 109

Odd	Page	section	break	(Word),	84
Office	2010

getting help, xli
new image modification functionality, 556
theme, default, 587

Office	Communicator
and Outlook To-Do Bar, 524
using with contact records, 594

Office.com
clip art, 551
sounds, 392

online	edition	of	book,	downloading,	xxxviii
OpenDocument	presentations,	450,	452
optional	attendees,	inviting	to	meetings,	613
organizing	tasks	(Outlook),	637
orientation.		page	orientation	(Excel);	worksheet	

cell	orientation
orphans/widows,	avoiding	(Word),	83
Outline	tab,	editing	lists	on	(PowerPoint),	352
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Outline	view	(Word)
levels, displaying, 13
reorganizing documents with, 14
sections, expanding/collapsing, 14
sections, promoting/demoting, 14
style area pane, displaying/hiding, 13
styles, displaying/hiding in, 13
subdocuments, expanding/collapsing, 14
subdocuments, opening, 14

outlines	(PowerPoint)
creating presentations based on, 330
expanding/collapsing, 330
inserting slides from, into presentations, 330
orientation, changing, 325
Rich Text Format, 330
saving presentations as, 450, 452
Word, in PowerPoint presentations, 330

Outlook	2010
address book, 591
archiving items automatically, 509
connecting to social networks from, 523
Conversation view (new feature), 574
creating folders, 483
Date Navigator, 624
email download settings, 482
Excel charts in, 553
exporting/importing, 510
formatting text in, 560
hyperlinks in, 557
Inbox. See Inbox (Outlook)
items, printing, 535
Journal. See Outlook Journal
junk mail in. See junk mail
mailbox size, managing, 572
modules, switching between, 525, 526
program window, customizing, 519, 520
Quick Print, 535
Quick Steps, 545
rules, 576
Schedule view (new feature), 622
ScreenTips in, 488
settings, changing, 486
SmartArt graphics in, 551
startup/exit behavior, changing, 509
styles, 562
text in, formatting, 560
themes, 566
views. See views (Outlook)
working environment, managing, 485, 519

Outlook	Journal.		Journal	module	(Outlook);	
journal	entries

accessing, 525
activating, 646
button, displaying, 647
display options, 647
recording information in, 647
settings, changing, 647
Timer, recording with, 649

Outlook	Options	dialog	box,	486
Advanced page, 507, 509, 510, 511
Calendar page, 496, 497, 499, 500, 501
Contacts page, 502
Language page, 506
Mail page, 486, 488, 489, 490, 492, 494, 495, 496
Notes And Journal page, 505, 648
Tasks page, 504

out-of-office	replies	(Outlook),	580
overhead	projector,	sizing	slides	for,	324
Overlay	Mode	(Outlook),	628
Overtype	mode,	in	email	messages,	488
Overview	pane	(PowerPoint),	310

closing, 310
entering text in, 344
rearranging slides in, 330
sizing, 310

P
packaging	presentations	for	CDs,	454
page	backgrounds	(Word),	94

color, adding, 95
pattern, adding, 95
watermarks, adding, 95, 96

page	borders	(Word),	94
Page	Break	Preview	view	(Excel),	231
page	breaks	(Excel),	170

adjusting, 172
deleting, 172
inserting, 172
manual, deleting all, 172
previewing, 172, 231

page	breaks	(Word),	82
avoiding widows/orphans, 83
deleting, 83
forcing, 83
inserting, 82
keeping paragraphs together, 83
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Page	Layout	view	(Excel),	231
page	margins	(Word),	81
page	numbers	(Word),	99
page	orientation	(Excel),	221
pages,	browsing	(Word),	54
panes	(PowerPoint),	310
panes,	freezing	(Excel),	228
paragraphs	(Outlook),	formatting,	561
paragraphs	(Word)

indentation, changing, 59
keeping lines together, 83
keeping together, 83
line spacing, changing, 63
page breaks, inserting before, 83
selecting, 2
spacing of, changing, 64
styles, applying, 51

passwords	(PowerPoint)
deleting, 464
opening presentations with, 463
setting, 455, 463, 464

passwords	(Word)
deleting, 27
modifying documents with, 27
opening documents with, 26
setting, 26

Paste	gallery,	previewing	in	(Excel),	189
Paste	Special	(Excel),	188
pasting	(Excel),	188,	189

formula results, 189
pattern,	adding	to	page	background	(Word),	95
pausing	presentation	recording,	479
PDF	file	format

saving documents in, 41
saving presentations in, 450, 452
saving workbooks in, 279, 281

pen	tool	(PowerPoint),	468,	469
People	Pane	(Outlook)

and Exchange Server accounts, 523
collapsed view, 522
contact information in, 522
contracting, 523
expanded view, 522, 523
finding items in, 522
switching between views, 523
Toggle button, missing, 523

percentage	complete	(Outlook),	638
Personal,	marking	email	messages	as,	515
phishing.		junk	mail
phone	directory,	printing	contacts	as,	539

phone	numbers,	entering	in	contact	records,	594
photo	albums	(PowerPoint),	320

adding captions, 322
adding photographs, 322
black-and-white photographs in, 322
creating, 320, 321, 322
editing, 320, 323
layout of photographs in, 322
photograph frames in, 322
templates, creating other presentations with, 320
templates, replacing photographs, 321
themes in, 322

photographs	(PowerPoint).		pictures;	images
adding to photo albums, 322
background, removing, 377
black-and-white, in photo albums, 322
brightness, adjusting, 377
captions, adding in photo albums, 322
color, changing, 378
compressing, 378
contrast, adjusting, 377
cropping, 374, 375
discarding changes, 379
effects, applying, 377, 378
formatting, 376
frames, in photo albums, 322
layout in photo albums, 322
modifying, 377
rearranging in photo albums, 322
replacing, 379
replacing in photo album templates, 321
sharpening/softening, 376, 377
tinting options, 376
transparency, changing, 378

Picture	diagrams	(SmartArt),	384
picture	presentations,	450,	451
Picture	Tools	contextual	tab,	556
picture	watermark,	adding	as	a	background	

(Word),	96
pictures.		photographs;	graphics;	images

applying artistic effects to, 104, 272, 556
as bullets (PowerPoint), 353
as document watermark, 96
as slide backgrounds, 336, 338
background, removing, 377, 556
brightness, adjusting, 377
clip art, saving as a file, 114
color in, 378, 556
compressing, 103, 378
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contact, in email messages, 503
contrast, adjusting, 377
copying to new location, 104, 272
cropping, 374, 375, 556
discarding changes, 379
effects, applying, 378
effects, options, 377
formatting, 376
in email responses, modifying, 556
inserting (Excel), 271
inserting (Outlook), 550
inserting (Word), 103
inserting in header/footer (Excel), 272
inserting multiple (Outlook), 550
modifying, 377
moving, 104, 272
replacing, 273, 379
sharpening/softening, 376, 377, 556
size/shape, changing, 104, 272
styles, applying, 105, 272
three-dimensional effects, applying, 556
tinting, 376
transparency, 378

plain	text,	email	messages	in,	487,	542
Playback	contextual	tab	(audio),	394,	395
Playback	contextual	tab	(video),	391,	392
plot	area,	410
plotting	charts.		charts	(Excel)
poll,	email,	creating,	543
Portable	Document	Format	(PDF).		PDF	file	format
portrait	aspect	ratios	for	cropping,	374
pound	sign	(#)	in	Excel,	163
PowerPoint	2010

customizing, 314
Professional Plus, and slide libraries, 327
program options, accessing, 318
themes, 333
views. See views (PowerPoint)

PowerPoint	Options	dialog	box
Add-ins page, 317
Advanced page, 316
General page, 314
Language page, 315
Proofing page, 314
Quick Access Toolbar page, 311
Save page, 314
Trust Center page, 317

PowerPoint	presentations.		presentations
PowerPoint	Show,	450,	451

PowerPoint	Viewer,	454
.ppt	file	format,	449
.pptx	file	format,	450,	451
presence	information,	in	email	messages,	503
presentation	equipment,	scheduling	with	Outlook,	

615,	618
presentation	sections,	339

adding, 340
appearance of, 340
applying themes to, 341
hiding slides in, 341
naming, 341
rearranging, 341
removing, 341

presentations
adding audio. See audio (PowerPoint)
adding slides, 326, 327
adding slides from outlines, 330
adding video. See videos
animating. See slide animations
annotations in, 344, 469
audio narration, adding, 479
autorun file, creating, 454
broadcasting, 473
cascading, 309
changing slide layout, 327
checking compatibility, 449, 450
colors, changing, 89, 333, 335
combining versions of, 444
commenting in, 436
comparing versions of, 444
compressing media, 453
creating based on Word outline, 330
creating from photo album template, 320
creating Quick Access Toolbar for, 312
customizing, 474
deleting slides,  331
delivering, 472
digital signatures in, 465
displaying on multiple monitors, 472
displaying specific slide, 303
dragging slides between, 331
effects, creating, 334
encrypting, 464
Excel worksheets, inserting, 404
file formats, 448
finding/replacing text, 441
fonts, changing, 89, 334, 335
fonts, finding/replacing, 442
handouts, 302, 325, 461
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presentations	(continued)
hyperlinks. See hyperlinks
linking graphics, 373
linking worksheets, 405
marking as final, 465
masters, viewing, 302, 306
moving around in, 303
multiple, viewing, 308
narrations, enabling, 471
navigating in, 476
opening, in Slide Show view, 450, 451
packaging for CDs, 454
panes. See panes (PowerPoint)
password-protecting, 455, 463, 464
pausing recording of, 479
pen color, changing, 469
personal information, removing, 462
photo albums, 320
previewing, 457, 458, 459
printing, settings for, 458, 459
printing as transparencies, 457
protecting information in, 462
rearranging slides, 330
recording, 478
reducing size, 453
rehearsing, 477
reusing slides, 327
reviewing, 444
revisions, accepting/rejecting, 444
Rich Text Format outlines in, 330
save options, customizing, 314
saving, as earlier version, 450
saving, as OpenDocuments, 450, 452
saving as outlines, 450, 452
saving, as PDF or XPS, 450, 452
saving, as picture presentations, 450, 451
saving, as videos, 455
saving, in different file formats, 450
saving, to removable media, 454
scrolling in, 303
setting up for delivery, 471
slide timings, setting up, 471
source citations in, 344
speaker notes. See speaker notes (PowerPoint)
switching among, 308, 309
tables, creating, 398
themes, 88, 334
transitions, 432
variations for different audiences, 474

viewing, 309, 310
views, switching, 302
Word outlines in, 330
worksheets, embedding, 405
zooming, 307

Presenter	view	(PowerPoint),	472
Preview	view	(Outlook),	625
previewing

presentations, 457, 458, 459
slide animations, 423

print	areas	(Excel)
adding ranges to, 169
clearing, 170
defining, 169
ignoring, 170
removing ranges from, 170

printers,	specifying,	458
printing

address books. See printing contact records
calendars. See printing calendars
comments, in presentations, 459
contact records. See printing contact records
email attachments, 535
email message list views, 535
email messages, 535
handouts, 459
hidden slides, 458
Outlook items, 535
presentations, settings for, 458, 459
row/column titles (Excel), 217
slides, 458
transparencies, 457
workbooks, 168
worksheets, 168, 172, 231

printing	calendars,	536,	537
excluding private appointments, 537
previewing, 537
styles, listed, 536

printing	contact	records,	538,	539
priority	(email	message),	setting/removing,	516
priority	(task),	638
privacy,	marking

appointments, 608
calendar items, 608
email messages, 515
events, 608
meetings, 608
tasks, 639

Process	diagrams	(SmartArt),	384
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program	windows	(Excel)
arranging multiple, 230
cascading, 230
hiding elements, 231
tiling, 230
unhiding elements, 231

program	windows	(Outlook),	519
customizing, 520

program	windows	(Word)
arranging multiple, 21
resizing, xxxii
stacking, 21
Styles pane, displaying, 51

promoting	sections	in	Outline	view	(Word),	14
properties	(Excel)

adding to display, 184
editing, 183
removing from display, 184
server, viewing, 183
viewing, 183, 184

properties	(Outlook	email	message),	517
publishing	(Excel).		saving
publishing	(Word).		blog	posts
Pyramid	diagrams	(SmartArt),	384

Q
Quick	Access	Toolbar	(Excel),	181

adding buttons, 182
moving, 182

Quick	Access	Toolbar	(PowerPoint),	311
adding buttons, 311, 312
restoring default buttons, 313

Quick	Click	setting	(Outlook),	511
Quick	Parts	(Word),	90

cover pages, 93
dynamic document properties, 92
fields, 93
inserting, 92
repositioning, 92
resizing, 92
saving, 117

Quick	Print	(Outlook),	535
Quick	Steps	(Outlook),	545

actions, adding/changing, 547, 548
changing, 545
creating, 546
custom, creating, 548

default actions, resetting to, 548
deleting, 548
gallery, 545
managing, 547
multiple accounts and, 546
names, changing, 547
performing, 547
properties, changing, 547
properties, viewing, 547
resetting, 548
setting up, 546
shortcut keys in, 546, 547
tooltip message, changing, 547

Quick	Styles.		WordArt	text
applying to tables (PowerPoint), 403
applying to text (Word), 51

Quick	Styles	gallery	(Outlook),	562
creating style sets, 565
including/excluding styles, 564

Quick	Tables	(Word),	69

R
read	receipt	(email)

requesting, 517, 543
responding to automatically, 495

read	status	(Outlook)
determination, customizing, 489
setting, 519

Reading	Pane	(Outlook),	521
closing, 523
customizing, 489
displaying, 523
in Mail module, 525
People Pane in. See People Pane (Outlook)

Reading	View	(PowerPoint),	302,	306
receipts	(email)

delivery, requesting, 495, 543
read, requesting, 543
read, responding to automatically, 495

receiving	email	messages,	482
recipients,	mail	merge

creating list, 145
excluding, 159
selecting, 145, 146

recording	audio,	393
recording	presentations,	478
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recurrence
in appointments, 608
in calendar items, 608
in events, 608
in meetings, 608
in tasks, 638
pattern, setting, 609

recurring
appointments, canceling recurrence, 609
appointments, creating, 608
appointments, editing, 609
calendar items, canceling recurrence, 609
calendar items, creating, 608
calendar items, editing, 609
events, canceling recurrence, 609
events, creating, 608
events, editing, 609
meetings, canceling recurrence, 609
meetings, creating, 608, 613
meetings, editing, 609
meetings, updating, 620
tasks, completing, vs. deleting, 642
tasks, creating, 639

redirecting	email	messages.		rules	(Outlook)
references.		Excel	formulas
regrouping	graphics,	371
rehearsing	presentations,	477
Relationship	diagrams	(SmartArt),	384
relative	cell	references	(Excel)

to cell contents, 243
to range in formula, 250

reminders	(Outlook).		flags	(Outlook)
adding to flagged items, 518
default, modifying, 498
dismissing, 529
overdue, displaying on status bar, 529
preventing, 498, 510
receiving on mobile devices, 604
rescheduling, 529
sound, setting, 510
task, assigning, 639
task, setting automatically, 504

reorganizing	in	Outline	view	(Word),	14
replacing	formatting	(Word),	56
replacing	text	(PowerPoint),	441
replacing	text	(Word),	56
replying	to	email	messages

automatically. See rules (Outlook)
with instant messages, 594

required	attendees,	inviting	to	meetings,	612
rescheduling	reminders,	529
resizing	ribbon,	xxxii
resources,	scheduling	automatically	(Outlook),	502
reusing	slides,	327
reviewers,	displaying	comments	by	(Word),	129
Reviewing	Pane	(Word)

comments, appearance in, 128
resizing, 129

reviewing	presentations,	444
revisions,	accepting/rejecting	(PowerPoint),	444
ribbon,	xxxi

buttons, appearance of, xxxii
commands on, xxxi
customizing (Excel), 178
customizing (PowerPoint), 316
expanding, 179
groups, displaying all commands in, xxxii
groups, displaying hidden, xxxii
minimized, selecting commands, 178
minimizing, 178
Office 2010 vs. older versions, 180
resetting to default, 180
resizing, xxxii
restoring old features, 180
tabs. See ribbon tabs

ribbon	tabs
command groups, creating custom, 179
custom, creating, 180
Developer tab, displaying, 43
groups, adding/removing commands, 179, 180
groups, moving, 180
hiding, 179
moving, 180
removing command groups, 179
resetting to default, 180

Rich	Text	Format	(RTF)
compatibility with email programs, 487
email messages, 487, 542
outlines, in presentations (PowerPoint), 330

rotating	(PowerPoint)
charts, 415
graphics, 369

rows	(Excel)
adjusting manually, 209
and columns, freezing, 229
deleting, 190, 192
freezing, 228
headers, selecting, 209
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headings, hiding/displaying, 232
headings, printing, 173
height, and text wrapping, 206
height, changing, 204, 208, 209, 210
hiding, 219
inserting, 189, 191
merging, 215
moving in, 167
references, 243
selecting, 162, 209
selecting data in, 163
sizing, 162
sorting by, 294
titles, printing, 217
transposing with columns, 189
unfreezing, 229
unhiding, 219

rows,	table	(Word)
deleting, 74
height, changing, 74
inserting, 74

RSS	feeds	(Outlook)
importing/exporting, 510
making available to other programs, 511
marking as unread, 511

rulers	(PowerPoint)
changing list indent with, 353
displaying, 353

rulers,	displaying/hiding	(Word),	16
rules	(Outlook),	576

actions, selecting, 578
applying, 578
Automatic Replies, 579
client, 576
conditions, selecting, 577
creating, 577, 578
criteria, 576
deleting, 579
dialing, 594
editing, 578
exceptions, selecting, 578
Exchange Server, 576
out-of-office replies, creating, 580
running on existing messages, 579
server, 576

rules,	conditional	formatting	(Excel),	296
creating, 299
defining, 297

S
Safe	Recipients	list	(Outlook),	582,	584
Safe	Senders	list	(Outlook),	582,	584
saving

clip art as a file, 114
delimited text files (Excel), 279
email attachments, 575
email messages as files, 575, 576
presentations, as earlier version, 450
presentations, as outlines, 450, 452
presentations, as videos, 455
presentations, file options for, 450, 452
slides, as graphics, 450, 451
text box as building block (Word), 117
Word documents, AutoSave, changing frequency, 

28
Word documents, options for, 41
Word documents, to SharePoint site, 32
Word documents, to Windows Live SkyDrive folder, 

32
workbooks, as templates, 279
workbooks, AutoSave, changing frequency, 184
workbooks, file options for, 281
workbooks, locations, 280
workbooks, to SharePoint site, 282
workbooks, to Windows Live SkyDrive folder, 282

scale	of	graphics,	changing,	369
scaling	worksheets,	221
Schedule	View	(Outlook),	622

display options, modifying, 500
displaying multiple calendars, 624

scheduling
appointments, 605
events, 606
meetings. See meetings
Smart Scheduling, 616

Scheduling	Assistant,	614
availability in, 614
color coding in, 614
for meeting requests, 611
options, changing, 501

scope	of	search,	changing	(Outlook),	532
Screen	Clipping	tool,	555
screen	clippings.		screen	images
screen	images

capturing, 103, 270, 555
inserting, 103, 270
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screen	shots.		screen	images
ScreenTips

comments, displaying in (Word), 129
creating for linked graphics (PowerPoint), 373
language, changing (Outlook), 506

scroll	bars	(Word),	3
scrolling

in documents, 3
in presentations, 303

Search	Folders	(Outlook),	533
accessing, 533
creating, 534
customizing, 534

searching	(Outlook).		Instant	Search	(Outlook);	
Search	Folders	(Outlook)

multiple address books, 484
section	bars	(PowerPoint).		presentation	sections
section	breaks	(Word),	83

deleting, 85
headers/footers, specifying, 84
inserting, 84
page settings, 84
types, 84

sections,	presentation.		presentation	sections
security	(PowerPoint),	317
security,	junk	mail.		junk	mail
selecting	(Excel),	163

data, 163
individual columns/rows, 162
worksheet content, 162

selecting	(PowerPoint)
chart elements, 414
table elements, 400
worksheet data, 409

selecting	(Word)
selection area, 2
text, 2

semicolons	in	email	messages,	484
sending	workbooks	as	Internet	faxes,	283
send/receive	status	of	email,	viewing,	530
sensitivity	of	email	messages,	setting,	516
Sent	Items	folder	(Outlook),	492
sentence,	selecting	(Word),	2
series,	data.		data	series	(Excel)
series	axis,	255
shading,	adding	to	SmartArt	graphics,	386
shape	of	WordArt	text,	changing,	381

shapes
adding text to, 107, 268, 383
adding to SmartArt graphics, 385
changing, 107, 268, 382
connecting, 383
converting SmartArt graphics to, 388
copying, 381
cropping graphics to fill or fit, 375
customizing, 107, 268
deleting, 386
drawing, 106, 267, 382
editing, 382
formatting, 107, 268
grouping, 108, 269
handles, 383
inserting into Outlook items, 551
moving, 386
positioning, 382
promoting/demoting in slides, 386
rotation, maintaining, 383
setting styles for, 381
size, maintaining, 383
sizing, 382
SmartArt, changing, 387, 388
SmartArt, changing color, 387
stacking multiple, 108, 268
text, adding, 268
text, formatting, 107
ungrouping, 108, 269

Shapes	gallery	(Outlook),	551
Shapes	gallery	(PowerPoint),	354
SharePoint

saving documents to, 32
saving workbooks to, 282

SharePoint	Server,	slide	libraries,	327
sharpening	pictures,	376,	377
shortcut	keys,	in	Quick	Steps	(Outlook),	546,	547
shortcuts,	accessing	(Outlook),	525
Side-By-Side	Mode	(Outlook),	628
signatures,	email,	585

adding, 517
creating, 586
electronic business cards as, 597
electronic business cards in, 586
in responses, 587
inserting manually, 587
removing, 587

Single	File	Web	Page	(Excel).		.html	file	format	
(Excel)
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sizing
chart elements, 415
charts, 415
columns, in worksheets, 162
graphics, 369
pictures, 104
PowerPoint panes, 310
rows in worksheets, 162
shapes, 382
slides, 324, 325
table elements, 401
text boxes, 356, 357, 358
worksheets in PowerPoint presentations, 405

sizing	handles	(graphics),	369
SkyDrive.		Windows	Live	SkyDrive
slide	animations,	421

adjusting, 425, 428
advanced, 423
Animation gallery, 422
Animation Painter, 424
Animation pane, 428
built-in, adding, 423
copying, 424
custom, applying, 424
duration, changing, 426
effect options, changing, 426
emphasis, 422
entrances/exits, 422
motion paths, 422, 426, 427
multiple, applying, 424
multiple, viewing details, 428
order, changing, 423, 426, 431
previewing, 423
removing, 423
repeating, 431
schematics for, 426
sound, adding, 431
start, delaying, 426
start action, specifying, 426
start triggers, 426
text, by word or letter, 431
text, changing after animation, 431
text, changing direction, 431
text, grouping paragraphs, 431
timing, 426, 431
viewing details, 428

slide	backgrounds,	336
custom, applying to all slides, 338
filling, 337, 338, 360, 362

gallery, 336
pictures, adjusting, 338
predefined, applying to all slides, 337

slide	layouts,	326,	327
slide	libraries

in SharePoint Server, 327
storing slides in, 329

Slide	Master	view	(PowerPoint),	302,	342
changing slide size/orientation in, 325
closing, 343
switching to, 343
working in, 343

slide	masters,	342
changing formatting, 343
default components, 342
exam coverage, 342

Slide	pane	(PowerPoint),	310
entering text in, 344
fitting slides in, 308

slide	projectors,	sizing	35mm	slides	for,	324
Slide	Show	view	(PowerPoint),	302,	306
slide	shows

broadcasting, 473
controlling from separate monitor, 472
customizing, 475
Presenter view, 472
sizing slides for, 324

Slide	Sorter	view	(PowerPoint),	302
presentation sections in, 340
rearranging slides in, 330
setting transitions in, 432
switching to, 306

slide	text
alignment, 347, 349, 362
animating, 431
case, changing, 347, 348
character spacing, changing, 347, 348
color, changing, 346, 348
columns, setting, 363
converting to lists, 350, 352, 353
copying/pasting, 345
creating new item, 344
deleting, 345
demoting, 344
direction, changing, 347, 349
direction, setting, 362, 363
editing, 345, 346
effects, changing, 347, 348
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slide	text	(continued)
embedded, animating, 429
entering, 344
font, changing, 346, 347
formatting, 346
formatting, clearing, 347, 350
formatting, copying, 347, 350
justifying, 349
layout, adjusting, 362
line/paragraph spacing, 347, 349
margins, setting, 362, 363
moving/copying, 345, 346
pasting, 346
promoting, 344
redoing a change, 346
replacing, 345
selected, appearance of, 304
selecting, 303, 304
sizing, 346, 347, 348
stacking, 362
style, changing, 347, 348
text effect, changing, 347
undoing changes, 345, 346
WordArt. See WordArt text
wrapping, 362, 363

slide	timings
applying, 477
default, in videos, 455
setting up, 471

slide	transitions,	421
adding, 433
adding sound to, 433
applying to all slides, 434, 477
automating, 434
refining, 433
removing, 434
speed, changing, 433

slides
accepting all changes on, 445
adding to presentations, 326, 327, 328, 329
animations. See slide animations
annotating, 468
attaching sounds/narration to, 393
audio in, 392. See also audio
bullet points, animating, 429
changing layout, 327
cutting/pasting, 331
date/time in, 338
deleting, 331, 332

design, changing. See slide masters
displaying specific, 303
dragging between presentations, 331
drawing on, 468
duplicating, 327
entering text, 344
erasing annotations, 469
fitting to window, 308
footers, adding, 338, 339
framing, when printing, 459
graphics in. See graphics
hidden, displaying, 332, 341
hidden, printing, 458
hiding, 332
hiding bullet points in, 330
hiding under section bar, 341
hiding/displaying objects on, 304
highlighter tool, 468
hyperlinks in, 372
inserting audio, 393
inserting from outlines, 330
inserting SmartArt graphics into, 385
inserting videos into, 390
linking graphics to, 373
masters. See slide masters
navigating, 476
orientation, changing, 325
pen tool, 468, 469
playing audio in, 394
playing videos in, 391
printing, 458
promoting/demoting shapes in, 386
rearranging, 330, 331
reused, formatting, 329
reusing, 327, 328, 329
saving as graphics, 450, 451
selecting text/objects, 304
sizing, 324, 325
slide numbers in, 338
storing in slide library, 329
thumbnails, dragging, 330
thumbnails, sizing, 330
transitions. See slide transitions
undoing deletion, 331
videos in, 389. See also videos
zooming, 307

SmartArt	graphics,	384
adding shapes to, 385
adding text to, 111, 266, 385, 552
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applying styles to, 111, 266, 367
Basic, importance of, 384
changing layout, 111
color, changing, 387
color scheme, changing, 111, 266
converting to bulleted lists, 388
converting to independent shapes, 388
creating, 385, 552
customizing, 386
Cycle type, 384
deleting a shape, 111, 266
diagram, inserting, 266
diagram layout, changing, 111
direction, switching, 387
elements, inserting, 553
elements, modifying, 553
elements, removing, 553
formatting text in, 386
hidden text in, 386
Hierarchy type, 384
in Outlook items, 551
inserting into documents, 110
inserting into slides, 385
layout, changing, 266, 387
List type, 384
Matrix type, 384
picture layout, applying to graphics, 370, 553
Picture type, 384
populating, 552
Process type, 384
promoting/demoting in, 386
Pyramid type, 384
Relationship type, 384
shading, 386
shapes, changing, 387
shapes, deleting from diagram, 111
shapes, resetting, 388
shapes, sizing, 387
styles, applying, 111
text, adding, 111
Text pane, displaying or hiding, 553
three-dimensional effects, 386
types, listed, 384

Smart	Scheduling,	616
snapping	objects	to	grid	(PowerPoint),	369
Snooze	option,	for	reminders	(Outlook),	529
social	networks,	connecting	to	from	Outlook,	523
softening	pictures,	377
soft	page	breaks	(Word),	82

sorting	data	(Excel),	293
by column/row, 294
on hidden columns, 294
on multiple columns, 294
on one column, 294
removing sort level, 295

sorting	table	content	(Word),	71
sorting	tasks	(Outlook),	635,	636,	637
sounds.		audio	(PowerPoint)

adding to animations, 431
adding to slide transitions, 433
as email message notifications, 489
attaching to slides, 393
downloading from Office.com, 392
for appointment reminders, 605
Outlook reminders, setting, 510

spaces,	hiding/displaying	(Word),	6
sparklines	(Excel),	273

changing type, 275
creating, 274
deleting, 275
style, applying, 275

speaker	notes	(PowerPoint)
adding, 302, 460
displaying, 306
orientation, changing, 325

special	characters,	locating	(Word),	56
special	effects,	adding	to	text	(Word),	48
spell	checking	(Outlook),	488
spell	checking	(PowerPoint),	440.		AutoCorrect	

(PowerPoint)
appearance of, 440
as you type, 440
customizing, 314
entire presentation, 440

spell	checking	(Word)
appearance of, 120
AutoCorrect exceptions, 127
AutoCorrect options, 125, 126, 127
automatic corrections, reversing, 126
dictionary, adding a word, 123
entire document, 123
error indicators, ignoring, 122
errors, fixing, 122
errors, hiding, 123
errors, visual indicators, 120
options, setting, 124
settings, customizing, 124

split	bar	(Word),	18,	19
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split	bars	(Excel),	228,	229
splitter	bars	(PowerPoint),	310
splitting	document	windows,	19
splitting	table	cells	(PowerPoint),	401
splitting	worksheet	windows,	229
square	aspect	ratio	for	cropping,	374
squares,	drawing,	382
stacking	order,	changing

graphics, 370
shapes, 108, 268
text boxes, 108

stacking	program	windows	(Word),	21
start	date	(tasks),	638
startup	folder	(Outlook),	509
stationery,	email	message,	587
status,	read	(Outlook).		read	status	(Outlook)
status	bar	(Outlook),	528

customizing, 529
displaying overdue reminders, 529

status	reports	for	tasks,	sending,	642
step	values	for	data	series	(Excel),	193
style	area	pane	(Word),	13,	15,	51
style	sets	(Outlook),	565
styles,	366,	562

applying to cells, 223
applying to chart shapes, 257
applying to charts, 257, 416, 418
applying to email text, 563, 587
applying to graphics, 367
applying to paragraphs, 51
applying to pictures, 105, 272
applying to SmartArt graphics, 266
applying to sparklines, 275
applying to tables, 68, 403
applying to WordArt, 380
clearing, 52
creating, 223, 563
displaying/hiding, 13, 15
galleries, 366
including/excluding from Quick Styles gallery, 564
locating, 56
modifying, 563
previewing, 51, 563
saving to templates, 563

Styles	pane,	50,	562
displaying, 51, 563
displaying visual preview of styles, 51

styling,	WordArt	text,	380
subdocuments	(Word),	14

subordinate	points	(PowerPoint),	386
subtracting	values	in	worksheets,	189
Suggested	Contacts	address	book,	503
sum	of	values,	in	a	range	(Excel),	237
switching	direction	(SmartArt),	387
switching	time	zones	(Outlook),	501
synchronous	scrolling	(Word),	21
synonyms,	finding	(PowerPoint),	444

T
tab	delimited	file	(Excel),	279
tab	stops

changing position, 61
clearing all, 61
deleting, 61
setting, 61

table	of	contents	(Word)
creating, 140, 141
updating, 141

table	properties	(Word),	73
tables	(Excel).		worksheets

cell width, 163
columns. See columns (Excel)
data entry, completing, 164
entering text in, 163
inserting, 404
rows. See rows (Excel)
selecting data, 163
sizing columns/rows, 162
sorting, 294

tables	(Outlook)
formatting, 561
printing contacts as, 539

tables	(PowerPoint)
aligning text in, 403
cell margins, setting, 403
columns, adding, 400
columns, deleting, 400
creating, 398
distributing column/rows evenly, 402
drawing, 399
editing, 399
erasing borders, 401
formatting, 402
formatting selected cells, 403
inserting, 398
merging cells, 401
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navigating in, 398
populating, 398
Quick Styles, applying, 403
resizing elements in, 401
rows, adding, 400
rows, deleting, 400
selecting elements of, 400
splitting cells in, 401
structure, changing, 399
styles, applying, 403
text direction, setting, 403

tables	(Word)
built-in style, applying, 68
cells, deleting, 74
cells, inserting, 74
cells, merging/splitting, 75
column width, changing, 74
columns, deleting, 74
columns, inserting, 74
converting table to text, 75
converting text to table, 67
deleting, 74
drawing, 67
gridlines, displaying, 71
header row, specifying, 71
inserting, 66
properties, displaying, 73
Quick Table, inserting, 69
row height, changing, 74
rows, deleting, 74
rows, inserting, 74
size of, changing, 73
sorting content, 71

tabs.		tab	stops
tabs,	worksheet.		worksheet	tabs
tags	(Excel),	183
task	requests,	recording	in	Outlook	Journal,	648
Tasks	button.	creating	tasks	from,	634
Tasks	List	(Outlook),	526,	635

changing sort order, 637
changing view, 637
completed tasks in, 636
creating tasks from, 633
fields in, 633
views of, listed, 635

Tasks	module	(Outlook)
content pane in, 526
creating tasks in, 633
displaying list views in, 527

Navigation Pane in, 483
setting options for, 504
Tasks List in, 635
To-Do List in, 635
viewing tasks in, 635

tasks	(Outlook)
assigned, appearance of, 641
assigned, changing options, 504
assigning, 640, 641
assigning due dates, 639
assigning flags to, 518
assigning to contacts, 594
assignments, accepting/declining, 641, 642
attaching items to, 639
attaching to email messages, 569
categorizing, 512, 639. See also color categories 

(Outlook)
changing view, 637
charts in, creating/modifying, 554
checklist view, 526
clip art, inserting, 551
color, changing, 504
completed, 636
copying, 638
creating, 632, 633, 634
creating appointments from, 604
creating events from, 607
default due date, changing, 504
deleting, 643
dismissing reminders, 529
finalizing, 642
flagging, 517
folders, creating, 637
grouping, 635, 636, 637
hyperlinks in, creating, 557. See also hyperlinks
in Calendar module, 635
in content pane, 526
marking as complete, 642
moving, 637
organizing, 637
percentage complete, 638
pictures, inserting, 550
priority, 638
privacy, assigning, 639
recurring, creating, 632, 639
reminders for, 639
reordering, 637
scheduling in calendar, 635
screen images, inserting, 555
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tasks	(Outlook)	(continued)
searching for, 531
setting automatically, 504
setting options for, 504
shapes, inserting, 551
sorting, 635, 636, 637
start date/due date, 638
status, 638
status reports, sending, 504, 642
task list, updating, 504
text in. See text
tracking, 639
viewing, 635
visual elements, inserting, 550

telephoning	contacts,	594
templates	(Excel),	saving	workbooks	as,	279
templates	(Outlook)

basing rules on, 576
saving styles to, 563

templates	(PowerPoint)
creating photo albums with, 320, 321
photo album, creating other presentations  

with, 320
replacing photographs in, 321

templates	(Word)
local, attaching, 43
web, attaching, 43

testing	hyperlinks	(PowerPoint),	373
text

adding to diagrams, 111
adding to shapes, 107, 383
adding to SmartArt graphics, 385, 552
alignment, changing, 560
alignment in tables, 403
applying local formatting, 560
applying styles, 563
as document watermark, 95
case, changing, 48
character formatting, applying, 48
character spacing, changing, 48, 560
character styles, changing, 560
color, changing, 560
columns, aligning text, 85
converting to table, 67
copying, 197
copying formatting, 561
creating styles, 563
deselecting, 2
effects, changing, 560

finding/replacing, in presentations, 441
font, changing, 560
font size, changing, 48
font style, changing, 560
formatting, 49, 560
formatting in shapes, 107, 268
formatting in SmartArt graphics, 386
highlighting, 48
highlighting search results, 56
in SmartArt graphics, hidden, 386
in worksheet cells, formatting, 204
indentation, changing, 560
locating (document), 55
modifying styles, 563
on slides. See slide text
paragraph formatting, changing, 561
paragraph styles, changing, 560
previewing styles, 563
Quick Styles, applying, 51
replacing, 56
selecting, 2. See also selecting (Word)
size, changing, 560
special effects, adding, 48
tables, converting from, 75
text boxes, inserting text into, 116
WordArt. See WordArt text
worksheet cell, orientation, changing, 205, 206
worksheet cell, wrapping, 205, 206

text	boxes	(PowerPoint).		text	placeholders	
(PowerPoint)

aligning, 359
applying styles to, 360, 362
aspect ratio, locking, 358
Autofit, 356, 358
columns in, 363
displaying Format Shape dialog box, 358
distributing, 359
editing text in, 344
effects, 361, 362
fills (background), 360, 362
fixed height, 344, 345
fixed width, 344, 345
formatting, 360, 363
gridlines/drawing guides, 359
horizontal alignment, 359
margins in, 363
moving, 344, 357, 358
outlines, 361, 362
overlapping, fixing, 359
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selecting, 344
shape, changing, 355
shape, default, 354
sizing, 356, 357, 358
stacking order, 359
text alignment in, 362
text direction in, 363
text layout in, 362
text wrapping in, 363
vertical alignment, 359

text	boxes	(Word)
copying, 116
direction of text, changing, 116
formatting, 116, 117
inserting, 115, 116
inserting text in, 116
linking, 116
saving as building block, 117
stacking order, changing, 108

text	case,	changing,	48
text	direction,	in	tables,	setting,	403
text	files	(Excel),	279
text	font,	changing,	48
text	placeholders	(PowerPoint),	344

Autofit and, 357
fitting text into, 357
formatting, 354
selecting text in, 303

text	watermark,	adding,	95
Themes	gallery	(Outlook),	567
Themes	gallery	(PowerPoint),	333,	334
themes	(Outlook),	566,	587

applying, 567
colors, 567
creating, 567
default, resetting, 588
effects, 567
fonts, 567
modifying, 567
Office, described, 587
previewing, 567
saving, 567

themes	(PowerPoint),	333
applying, 334, 341
changing, 334
colors, 333, 334, 335
deleting, 335
effects, 334

fonts, 334, 335
in photo albums, 322
saving, 334

themes	(Word)
applying, 88
changing, 88
colors, 89
deleting, 89
fonts, 89
saving, 89

Thesaurus	(PowerPoint),	442
three-dimensional	(3D)

charts, formatting, 413
effects, adding to SmartArt graphics, 386
picture effects, applying, 556

tick-mark	labels,	411
tiling	program	windows	(Excel),	230
tiling	program	windows	(Word),	21
time,	inserting	in	headers/footers,	99
time	zones,	500

changing, 501
multiple, displaying, 501
switching between, 501

Timer,	recording	journal	entries	with	(Outlook),	649
tinting	pictures,	376
To-Do	Bar	(Outlook),	524

and Office Communicator, 524
changing content, 508
closing, 524
creating tasks from, 633
Date Navigator in, 524
displaying, 524
expanding/minimizing, 524
width, changing, 521

To-Do	Bar	Task	List	(Outlook),	635
To-Do	List	(Outlook	tasks),	526,	635

changing sort order, 637
creating tasks from, 633
sorting tasks in, 636

tracking	email	messages,	495
tracking	meeting	request	responses,	619
transitions,	slide.		slide	transitions
Transitions	gallery	(PowerPoint),	433
transparencies,	printing	(PowerPoint),	457
transparency	of	pictures,	changing,	378
transposing	rows/columns	(Excel),	189
trendlines,	chart,	adding/removing,	413
tri-fold,	printing	calendar	as,	537
triggers,	slide	animation,	426
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U
unfreezing	columns/rows	(Excel),	229
ungrouping	graphics,	371
unhiding

columns/rows (Excel), 219
Formula Bar (Excel), 232
worksheets, 227

unified	messaging	system,	Outlook	contact	
options	and,	594

updating	linked	worksheets,	405
user	interface.		working	environment

V
value	axis,	255,	410

adding/removing, 412
formatting, 418

values	(Excel)
adding/subtracting/multiplying/dividing, 189
in formulas, pasting, 189

versions	(Excel),	184
replacing current with previous, 184
saved, displaying, 184
temporary (unsaved), deleting, 185
temporary (unsaved), displaying, 184

versions	(Word),	28
replacing current with previous, 29
saved, displaying, 28
temporary (unsaved), deleting, 29
temporary (unsaved), displaying, 29

vertical	ruler,	displaying/hiding	(Word),	16
videos

automatic play, setting, 391
clip art, inserting into slides, 389, 390
configuring, 456
digital files, inserting into slides, 389, 390
editing, 392
fading in/out, 392
formatting, 391
full-screen play, setting, 391
hiding while not playing, 391
inserting, 389, 3990
inserting from websites, 389, 390
looping, 391
previewing, 456
rewinding, 391

saving presentations as, 455
settings, changing, 391
trimming, 392
volume, changing, 391

view	options,	changing	(Word),	10
View	Shortcuts	toolbar	(PowerPoint),	306
View	toolbar	(Excel),	231
viewing

different parts of same presentation, 309
multiple presentations, 308

views	(Excel),	228
freezing columns/rows, 228, 229
Full Screen, 231
multiple workbook windows, 230
Normal, 231
Page Break Preview, 231
Page Layout, 231
splitting, 229
View toolbar, 231
zooming, 232

views	(Outlook)
Active, 625
Calendar, 625
Conversation, 574
custom, defining, 483
Day, 622
Day, events in, 606
for tasks, 635
List, 625
Month, 622
Month, events in, 606
Notes module, changing, 644
Overlay Mode (calendars), 628
Preview, 625
Schedule, 622
Side-By-Side Mode (calendars), 628
switching, 483
task, changing, 637
time periods in, 622
Week, 622
Week, events in, 606
Work Week, 622
Work Week, events in, 606

views	(PowerPoint),	302
Handout Master, 302
Normal, 302, 306, 310, 331
Notes Master, 302
Notes Page, 302
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Reading View, 302, 306
Slide Master, 302, 325, 342
Slide Show, 302, 306
Slide Sorter, 302, 330

views	(Word)
multiple document windows, 21
splitting, 19
switching, 6

voting	buttons,	email,	543
adding to messages, 517
labels, changing, 543

voting	requests,	email,	processing,	495

W
watermarks

adding, 95
picture, adding, 96

web	beacons.		graphics,	in	junk	mail
attaching to documents, 43

webpages.		.html	file	format	(Excel)
banner, sizing slides for, 324
hyperlinks to, creating, 558
linking graphics to, 373
worksheet hyperlinks to, creating, 199

websites
displaying from contact records, 594
videos from, inserting in slides, 389, 390
videos from, unable to copy, 390

week	numbers	(Outlook),	496,	499,	624
displaying, 500

Week	view	(Outlook),	622
events in, 606
scrolling in, 624

weeks.		work	week	(Outlook)
displaying in Calendar pane, 623
displaying in Outlook Date Navigator, 624

widows/orphans,	avoiding	(Word),	83
windows

cascading (Excel), 230
cascading (PowerPoint), 308
side by side (PowerPoint), 308
side by side (Word), 20
stacking (Word), 20

Windows	Live	SkyDrive,	31,	281
folder, creating (Excel), 282
folder, creating (Word), 32
saving documents to, 32
saving workbooks to, 282

Word	2010
AutoCorrect, 125
documents, hyperlinks to, 557
grammar checking, 120
opening multiple windows, 20
outlines, in PowerPoint presentations, 330
program windows, arranging multiple, 21
Quick Parts, 90
spell checking, 120

Word	Options	dialog	box,	121,	124
WordArt	objects

creating from text, 109
inserting, 109

WordArt	text,	380.		Quick	Styles
adding effects to, 381
changing shape of, 381
creating, 380
formatting, 109
formatting in charts, 419
handles, 381
styling, 380, 381
transforming, 381

words,	selecting	(Word),	2
work	week	(Outlook),	496,	497
Work	Week	view	(Outlook),	622

events in, 606
scrolling in, 624

workbook	properties,	183
adding to display, 184
editing, 183
removing from display, 184
server, viewing, 183
viewing, 183, 184

workbooks
adding Quick Access Toolbar buttons, 182
AutoSave, changing frequency, 184
copying worksheets between, 226
inserting worksheets into, 162
moving worksheets in, 226
new, creating worksheet hyperlinks to, 200
opening in multiple windows, 229
opening second instance in separate window, 230
printing worksheets in, 168, 169
program windows, arranging multiple, 230
save locations, 280
saving, options for, 278, 281
saving as template, 279
saving for web browsers, 278
saving to a SharePoint site, 282
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workbooks	(continued)
saving to Windows Live SkyDrive, 282
sending as email attachments, 284
sending as Internet faxes, 283
sending links to, 284
versions, displaying/deleting temporary (unsaved), 

184, 185
versions, displaying saved, 184
versions, replacing current with previous, 184
worksheets in, default number, 165

workday	limitations	(Outlook),	497
working	environment

Excel, managing, 165, 305
Outlook, managing, 485, 519
PowerPoint, changing language of, 506

worksheet	cell	orientation,	205,	206
worksheet	hyperlinks,	198

appearance of, 199
creating email messages with, 201
editing, 201
removing, 201
selecting for formatting, 199
targets, changing, 201
to files, creating, 200
to named ranges, creating, 200
to new workbooks, creating, 200
to webpages, creating, 199
to worksheets, creating, 200

worksheet	tabs,	227
worksheets.		tables	(Excel),	workbooks

aligning cell text in, 206
AutoFill feature, 193
average of a range, 238
cell borders, adding, 207
cell borders, removing, 207
cell fill color, changing, 207
cell reference range, absolute, 250
cell reference range, relative, 250
cell references, 242
cell references, absolute, 243
cell references, in different workbook, 244
cell references, relative, 243
Cell Styles gallery, 222
cell text wrapping in, and row height, 205, 206
cells, formatting, 204, 205, 206
cells, merging/splitting, 215, 216
cells, moving among, 166, 167

chart axes, displaying/hiding, 262
chart legend, adding/removing/moving, 261
chart types, 254
charts, adding/removing titles, 260, 261
charts, applying styles, 257
charts, changing data range, 259
charts, changing layout, 257
charts, changing size, 258
charts, changing type, 256
charts, data labels, 261
charts, displaying data table, 262
charts, editing data, 259
charts, formatting elements, 263
charts, gridlines, 262
charts, moving, 258
charts, plotting selected data, 256
charts, switching rows/columns, 256
clip art, inserting, 264
colors, changing theme, 89
column references, absolute, 243
column/row headings, hiding/displaying, 232
column/row headings, printing, 173
columns in. See columns (Excel)
comments, deleting, 286
comments, editing, 286
comments, inserting, 285
comments, moving among, 286
comments, resizing/moving, 286
comments, temporarily displaying, 285
conditional logic arguments, 246
copied or cut cells, inserting, 191
copying, 226
copying cell formatting, 206
copying currency amounts, 197
copying data from, 404
copying formatting only, 197
copying numeric data, 197
copying text, 197
counting cells with values, 238
counting empty cells, 238
customizing, 232
custom styles, creating, 223
data regions, moving in, 167
data series in. See data series (Excel)
deleting, 162
deleting cells, 190, 192
deleting rows/columns, 190, 192
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diagrams, adding text to shapes, 266
diagrams, changing layout, 266
diagrams, deleting a shape, 266
diagrams, inserting, 266
displaying, 231
embedding in presentations, 405
error when inserting cells, 191
filling data series in, 193
filtering data, 290
fitting on page, 221
fonts, changing, 89
footers, changing height, 221
Format Painter in, 206
formulas, order of calculation, 241
freezing rows/columns in, 228
full screen mode, 231
gridlines in, 232
gridlines, printing, 173
grouping, 169, 227
headers, changing height, 221
headers/footers in, 174
hidden, displaying, 227
hidden cells, finding, 219
hiding, 226
hyperlinks to, creating, 200
inserting cells, 189, 190, 191
inserting in PowerPoint presentations, 404
inserting new, 162
inserting rows/columns, 189, 191
insertions, formatting, 191
linked, updating, 405
linking cells in, 188
linking to, from PowerPoint, 405
margins, changing, 221
mathematical operations in, 189
maximizing work area, 231
moving, 226
moving around in, 166, 167
named ranges, changing name, 249
named ranges, defining, 248, 249
named ranges, deleting, 249
navigating, 166
number formatting in, 210
number in workbook, default, 165
page breaks, adjusting, 172
page breaks, deleting, 172
page breaks in, 170

page breaks, inserting, 172
page breaks, previewing, 172
page orientation, changing, 221
pasting data in, 188
pasting formula results in, 189
pictures, applying artistic effects, 272
pictures, changing size/shape, 272
pictures, copying to new location, 272
pictures, inserting, 271, 272
pictures, moving, 272
pictures, replacing, 273
plotting charts, 254
print areas in. See print areas (Excel)
printing, 168, 169
properties, searching by, 167
references, different workbook, 244
references, same workbook, 243
removing splits, 229
renaming, 162, 227
rows in. See rows (Excel)
rows, moving in, 167
scaling, 221
screens, moving between, 166
selecting data in, 162, 409
shapes, adding text, 268
shapes, changing, 268
shapes, customizing, 268
shapes, drawing, 267
shapes, formatting, 268
sizing, in PowerPoint, 405
sizing columns/rows, 162
SmartArt diagrams, inserting, 266
SmartArt graphics, applying a style, 266
SmartArt graphics, changing layout, 266
sorting data, 293, 294
sparklines in, 273, 274, 275
splitting, 229
styling, 223
text alignment in cells, 205
text orientation in, 205, 206
themes, applying, 88
themes, changing, 88
themes, saving, 89
transposing rows/columns, 189
wrapping cell text, 206
zooming, 232
zoom level, changing, 233

	 worksheets	(continued)	 	 689



X
.xls	file	format	(Excel),	278,	279
.xlsb	file	format	(Excel),	278
.xlsm	file	format	(Excel),	278
.xlsx	file	format	(Excel),	benefits	of,	278
.xml	file	format,	279

saving workbooks in, 278
XML	Paper	Specification	(XPS).		.xps	file	format
.xps	file	format

saving documents in, 41
saving presentations in, 450, 452
saving workbooks in, 281

Y
year,	defining	first	week	of	(Outlook),	497

Z
Zoom	controls	(Outlook),	528
zoom	level	(Excel),	233
zoom	level	(PowerPoint),	307
Zoom	toolbar	(Excel),	232
zooming

documents, 18
presentations, 307
on selected worksheet cells, 233
worksheets, 232
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